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C H A P T E R 1
Getting Started with the Secure Firewall
Migration Tool

• About the Secure Firewall Migration Tool, on page 1
• What’s New in the Secure Firewall Migration Tool, on page 4
• Licensing for the Secure Firewall Migration Tool, on page 7
• Platform Requirements for the Secure Firewall Migration Tool, on page 7
• Requirements and Prerequisites for the ASA with FPS Configuration File, on page 7
• Requirements and Prerequisites for Threat Defense Devices, on page 8
• ASA with FPS Configuration Support, on page 8
• Guidelines and Limitations, on page 12
• Supported Platforms for Migration, on page 17
• Supported Target Management Center for Migration, on page 18
• Supported Software Versions for Migration, on page 19

About the Secure Firewall Migration Tool
This guide contains information on how you can download the Secure Firewall migration tool and complete
the migration. In addition, it provides you troubleshooting tips to help you resolve migration issues that you
may encounter.

The sample migration procedure (Sample Migration: ASA with FPS to Threat Defense 2100 ) included in
this book helps to facilitate understanding of the migration process.

The Secure Firewall migration tool converts supported ASA with FPS configurations to a supported threat
defense platform. The Secure Firewall migration tool allows you to automatically migrate supported ASA
with FPS features and policies to threat defense. You must manually migrate all unsupported features.

The Secure Firewall migration tool gathers ASA with FPS information, parses it, and finally pushes it to the
Secure Firewall Management Center. During the parsing phase, the Secure Firewall migration tool generates
a Pre-Migration Report that identifies the following:

• ASA with FPS (Firewall Services) configuration items that are fully migrated, partially migrated,
unsupported for migration, and ignored for migration.

• ASAwith FPS configuration lines with errors that lists the ASAwith FPS CLIs which the Secure Firewall
migration tool cannot recognize; this blocks the migration.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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If there are parsing errors, you can rectify the issues, reupload a new configuration, connect to the destination
device, map the ASAwith FPS interfaces to threat defense interfaces, map security zones and interface groups,
and proceed to review and validate your configuration. You can thenmigrate the configuration to the destination
device.

Console

The console opens when you launch the Secure Firewall migration tool. The console provides detailed
information about the progress of each step in the Secure Firewall migration tool. The contents of the console
are also written to the Secure Firewall migration tool log file.

The console must stay open while the Secure Firewall migration tool is open and running.

When you exit the Secure Firewall migration tool by closing the browser on which the web interface is running,
the console continues to run in the background. To completely exit the Secure Firewall migration tool, exit
the console by pressing the Command key + C on the keyboard.

Important

Logs

The Secure Firewall migration tool creates a log of each migration. The logs include details of what occurs
at each step of the migration and can help you determine the cause if a migration fails.

You can find the log files for the Secure Firewall migration tool in the following location:
<migration_tool_folder>\logs

Resources

The Secure Firewall migration tool saves a copy of the Pre-Migration Reports, Post-Migration Reports,
ASA with FPS configs, and logs in the resources folder.

You can find the resources folder in the following location:
<migration_tool_folder>\resources

Unparsed File

The Secure Firewall migration tool logs information about the configuration lines that it ignored in the unparsed
file. This Secure Firewall migration tool creates this file when it parses the ASA with FPS configuration file.

You can find the unparsed file in the following location: <migration_tool_folder>\resources

Search in the Secure Firewall Migration Tool

You can search for items in the tables that are displayed in the Secure Firewall migration tool, such as those
on the Optimize, Review and Validate page.

To search for an item in any column or row of the table, click the Search ( ) above the table and enter the
search term in the field. The Secure Firewall migration tool filters the table rows and displays only those that
contain the search term.

To search for an item in a single column, enter the search term in the Search field that is provided in the
column heading. The Secure Firewall migration tool filters the table rows and displays only those that match
the search term.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Ports

The Secure Firewall migration tool supports telemetry when run on one of these 12 ports: ports 8321-8331
and port 8888. By default, Secure Firewall migration tool uses port 8888. To change the port, update port
information in the app_config file. After updating, ensure to relaunch the Secure Firewall migration tool
for the port change to take effect. You can find the app_config file in the following location:
<migration_tool_folder>\app_config.txt.

We recommend that you use ports 8321-8331 and port 8888, as telemetry is only supported on these ports. If
you enable Cisco Success Network, you cannot use any other port for the Secure Firewall migration tool.

Note

Cisco Success Network

Cisco Success Network is a user-enabled cloud service. When you enable Cisco Success Network, a secure
connection is established between the Secure Firewall migration tool and the Cisco cloud to stream usage
information and statistics. Streaming telemetry provides a mechanism to select data of interest from the Secure
Firewall migration tool and to transmit it in a structured format to remote management stations for the following
benefits:

• To inform you of available unused features that can improve the effectiveness of the product in your
network.

• To inform you of additional technical support services and monitoring that is available for your product.

• To help Cisco improve our products.

The Secure Firewall migration tool establishes and maintains the secure connection and allows you to enroll
in the Cisco Success Network. You can turn off this connection at any time by disabling the Cisco Success
Network, which disconnects the device from the Cisco Success Network cloud.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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What’s New in the Secure Firewall Migration Tool
Supported FeaturesVersion

• Secure Firewall migration tool now supports migration of multiple security
contexts from Secure Firewall ASA to threat defense devices. You can choose
to migrate configurations from one of your contexts or merge the configurations
from all your routed firewall mode contexts and migrate them. Support for
merging configurations from multiple transparent firewall mode contexts will
be available soon. See Select the ASA Primary Security Context for more
information.

• The migration tool now leverages the virtual routing and forwarding (VRF)
funtionality to replicate the segregated traffic flow observed in a multi-context
ASA environment, which will be part of the new merged configuration. You
can check the number of contexts the migration tool has detected in a new
Contexts tile and the same after parsing, in a new VRF tile in the Parsed
Summary page. In addition, the migration tool displays the interfaces to which
these VRFs are mapped, in the Map Interfaces to Security Zones and
Interface Groups page.

• You can now try the whole migration workflow using the new demo mode in
Secure Firewall migration tool and visualize how your actual migration looks
like. See Using the Demo Mode in Firewall Migration Tool for more
information.

• With new enhancements and bug fixes in place, Secure Firewall migration tool
now provides an improved, faster migration experience for migrating Palo
Alto Networks firewall to threat defense.

5.0

The Secure Firewall migration tool 4.0.3 includes bug fixes and the following new
enhancements:

• The migration tool now offers an enhanced Application Mapping screen for
migrating PAN configurations to threat defense. See Map Configurations with
Applications in Migrating Palo Alto Networks Firewall to Secure Firewall
Threat Defense with the Migration Tool guide for more information.

4.0.3

The Secure Firewall migration tool 4.0.2 includes the following new features and
enhancements:

• The migration tool now has an always-on telemetry; however, you can now
choose to send limited or extensive telemetry data. Limited telemetry data
inludes few data points, whereas extensive telemetry data sends a more detailed
list of telemetry data. You can change this setting from Settings > Send
Telemetry Data to Cisco?.

4.0.2

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Supported FeaturesVersion

The Secure Firewall migration tool 4.0.1 includes the following new features and
enhancements:

The Secure Firewall migration tool now analyzes all objects and object groups based
on both their name and configuration, and reuses objects that have the same name
and configuration. Only network objects and network object groups were analyzed
based on their name and configuration before. Note that the XML profiles in remote
access VPNs are still validated only using their name.

4.0.1

The Secure Firewall Migration Tool 3.0.2 includes bug fixes for remote access VPN
configuration migration from ASA with FirePOWER Services to Management
Center versions 7.2 or higher.

3.0.2

• For ASA with FirePOWER Services, Check Point, Palo Alto Networks, and
Fortinet, Secure Firewall 3100 series is only supported as a destination device.

3.0.1

The Secure Firewall migration tool 3.0 supports:

• Remote Access VPN migration from ASA with FirePOWER Services if the
destination management center is 7.2 or later. You can perform RA VPN
migration with or without Secure Firewall Threat Defense. If you select the
migration with threat defense, then the threat defense version must be 7.0 or
later.

• Site-to-Site VPN pre-shared key automation from ASA with FirePOWER
Services.

• The following must be performed as part of the pre-migration activity:

• The ASA with FirePOWER Services trustpoints must be manually
migrated to the management center as PKI objects.

• AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan
Package), External Browser package, and AnyConnect profiles must be
retrieved from source ASA.

• AnyConnect packages must be uploaded to the management center.

• AnyConnect profiles must be directly uploaded to the management center
or from the Secure Firewall migration tool.

• The ssh scopy enable command must be enabled on the ASA with
FirePOWERServices to allow retrieval of profiles from the Live Connect
ASA.

3.0

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Supported FeaturesVersion

The Secure Firewall migration tool supports the migration of the Cisco Firewall
Services (FPS) configurations to threat defense if the target management center and
threat defense is 6.5 or later.

• Migrate ASA with FPS access rules as management center Prefilter
rules—Mapping of ASAwith FPS access rules to management center for tailor
deep inspection by Firewall. The access policy contains rules with IPs and
ports.

You can use prefilter and access control policies to block or allow
traffic.

Note

The access rules from ASA are migrated as management center prefilter rules.
The access rules from FPS are migrated into management center as access
control policy.

• The ASA with FPS rules is migrated as follows:

ASA to FPS redirection ACLs are migrated as prefilter rules (conditional).

You can migrate the FPS rules using the Secure Firewall
migration tool only if the FPS module is managed through
management center.

Note

• If the source redirection ACL has Action=DENY—migrated as
management center Prefilter rule with Action=Fastpath. Also, this
particular ACL is positioned as the first ACL rule in the DISABLED
state.

• If the source redirection ACL hasAction=Permit—will not be migrated
by Secure Firewall migration tool.

• The Secure Firewall migration tooll does not support migration of
ASDM-managed FPS rules into the Secure Firewall migration tool. Therefore
you must be aware of the configuration information before you migrate while
selecting the source configuration (ASA with FPS).

The following ASA VPN configuration migration to threat defense:

• Crypto map (static/dynamic) based VPN from ASA

• Route-based (VTI) based ASA VPN

• Certificate-based VPN migration from ASA

Note • ASA trustpoint or certificates is migrated manually and part of
pre-migration activity.

• ASA trustpoint must be migrated as management center PKI
objects. PKI objects are used in the Secure Firewall migration
tool while creating certificate-based VPN topologies.

2.4

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Licensing for the Secure Firewall Migration Tool
The Secure Firewall migration tool application is free and does not require license. However, the management
center must have the required licenses for the related threat defense features to successfully register threat
defense devices and deploy policies to it.

Platform Requirements for the Secure Firewall Migration Tool
The Secure Firewall migration tool has the following infrastructure and platform requirements:

• Runs on a Microsoft Windows 10 64-bit operating system or on a macOS version 10.13 or higher

• Has Google Chrome as the system default browser

• (Windows) Has Sleep settings configured in Power & Sleep to Never put the PC to Sleep, so the system
does not go to sleep during a large migration push

• (macOS) Has Energy Saver settings configured so that the computer and the hard disk do not go to sleep
during a large migration push

Requirements and Prerequisites for the ASA with FPS
Configuration File

You can obtain an ASA with FPS configuration file either manually or by connecting to a live ASA with FPS
from the Secure Firewall migration tool.

ASA with FPS configuration file migration into the Secure Firewall migration tool is a two-step process:

• You can import the ASA with FPS configuration file using the manual method or live-connect method

• You must import the FPS configuration file by connecting to the management center that manages the
FPS, and by selecting the required source ACL policy that needs to be migrated.

The ASA with FPS configuration file that you manually import into the Secure Firewall migration tool must
meet the following requirements:

• Has a running configuration that is exported from an ASAwith FPS device in a single mode configuration
or specific context of a multiple context mode configuration. See Export the ASAwith FPS Configuration
File, on page 24.

• Includes the version number.

• Contains only valid ASA with FPS CLI configurations.

• Does not contain syntax errors.

• Has a file extension of .cfg or .txt.

• Uses a file encoding of UTF-8.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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• Has not been hand coded or manually altered. If you modify the ASA with FPS configuration, we
recommend that you test the modified configuration file on the ASA with FPS device to ensure that it is
a valid configuration.

• Does not contain the "--More--" keyword as text.

Requirements and Prerequisites for Threat Defense Devices
When you migrate to the management center, it may or may not have a target threat defense device added to
it. You can migrate shared policies to a management center for future deployment to a threat defense device.
To migrate device-specific policies to a threat defense, you must add it to the management center. As you
plan to migrate your ASA with FPS configuration to threat defense, consider the following requirements and
prerequisites:

• The target threat defense device must be registered with the management center.

• The threat defense device can be a standalone device or a container instance. It must not be part of a
cluster or a high availability configuration.

• The target native threat defense device must have at least an equal number of used physical data
and port channel interfaces (excluding ‘management-only’ and subinterfaces) as that of the ASA
with FPS; if not you must add the required type of interface on the target threat defense device.
Subinterfaces are created by the Secure Firewall migration tool that are based on physical or port
channel mapping.

• If the target threat defense device is a container instance, at minimum it must have an equal number
of used physical interfaces, physical subinterfaces, port channel interfaces, and port channel
subinterfaces (excluding ‘management-only’) as that of the ASA with FPS; if not you must add the
required type of interface on the target threat defense device.

• Subinterfaces are not created by the Secure Firewall migration tool, only
interface mapping is allowed.

• Mapping across different interface types is allowed, for example: physical
interface can be mapped to a port channel interface.

Note

ASA with FPS Configuration Support
Supported ASA with FPS Configurations

The Secure Firewall migration tool can fully migrate the following ASA with FPS configurations:

• Network objects and groups

• Service objects, except for those service objects configured for a source and destination

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Though the Secure Firewall migration tool does not migrate extended service
objects (configured for a source and destination), referenced ACL and NAT rules
are migrated with full functionality.

Note

• Service object groups, except for nested service object groups

Since nesting is not supported on the management center, the Secure Firewall
migration tool expands the content of the referenced rules. The rules, however,
are migrated with full functionality.

Note

• IPv4 and IPv6 FQDN objects and groups

• IPv6 conversion support (Interface, Static Routes, Objects, ACL, and NAT)

• Access rules that are applied to interfaces in the inbound direction and global ACL

• Auto NAT, Manual NAT, and object NAT (conditional)

• Static routes, ECMP routes which are not migrated

• Physical interfaces

• Secondary VLANs on ASA with FPS interfaces are not migrated to threat defense.

• Subinterfaces (subinterface ID is always set to the same number as the VLAN ID on migration)

• Port channels

• Virtual tunnel interface (VTI)

• Bridge groups (transparent mode only)

• IP SLA Monitor

The Secure Firewall migration tool creates IP SLA Objects, maps the objects with the specific static
routes, and migrates the objects to management center.

IP SLA monitor defines a connectivity policy to a monitored IP address and tracks the availability of a
route to the IP address. The static routes are periodically checked for availability by sending ICMP echo
requests and waiting for the response. If the echo requests are timed-out, the static routes are removed
from the routing table and replaced with a backup route. SLA monitoring jobs start immediately after
deployment and continue to run unless, you remove the SLAmonitor from the device configuration, that
is, they do not age out. The IP SLAmonitor objects are used in the Route Tracking field of an IPv4 static
route policy. IPv6 routes do not have the option to use SLA monitor through route tracking.

IP SLA Monitor is not supported for non-threat defense flow.Note

• Object Group Search

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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Enabling object group search reduces memory requirements for access control policies that include
network objects. We recommend you to enable object group search that enhances optimal memory
utilization by access policy on threat defense.

• Object Group Search is unavailable for management center or threat defense
version earlier than 6.6.

• Object Group Search will not be supported for non-threat defense flow and
will be disabled.

Note

• Time-based objects

When the Secure Firewall migration tool detects time-based objects that are referenced with access-rules,
the Secure Firewall migration tool migrates the time-based objects and maps them with respective
access-rules. Verify the objects against the rules in the Review and Validate Configuration page.

Time-based objects are access-list types that allow network access on the basis of time period. It is useful
when you must place restrictions on outbound or inbound traffic on the basis of a particular time of the
day or particular days of a week.

• You must manually migrate timezone configuration from source ASA with
FPS to target FTD.

• Time-based object is not supported for non-threat defense flow and will be
disabled.

• Time-based objects are supported on management center version 6.6 and
above.

Note

• Site-to-Site VPN Tunnels

• Site-to-Site VPN—When the Secure Firewall migration tool detects crypto map configuration in
the source ASA with FPS, the Secure Firewall migration tool migrates the crypto map to the
management center VPN as point-to-point topology.

• Crypto map (static/dynamic) based VPN from ASA

• Route-based (VTI) ASA VPN

• Certificate-based VPN migration from ASA

• ASA trustpoint or certificates migration to the management center must be performed manually and
is part of the pre-migration activity.

• Dynamic-Route Objects, BGP, and EIGRP

• Policy-List

• Prefix-List

• Community List

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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• Autonomous System (AS)-Path

• Remote Access VPN

• SSL and IKEv2 protocol

• Authentication methods—AAA only, Client Certificate only, SAML, AAA, and Client Certificate

• AAA—Radius, Local, LDAP, and AD

• Connection Profiles, Group-Policy, Dynamic Access Policy, LDAP Attribute Map, and Certificate
Map

• Standard and Extended ACL

• RA VPN Custom Attributes and VPN load balancing

• As part of pre-migration activity, perform the following:

• Migrate the ASA trustpoints manually to the management center as PKI objects.

• Retrieve AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan Package),
External Browser package, and AnyConnect profiles from the source ASA.

• Upload all AnyConnect packages to the management center.

• Upload AnyConnect profiles directly to the management center or from the Secure Firewall
migration tool.

• Enable the ssh scopy enable command on the ASA to allow retrieval of profiles from the Live
Connect ASA.

Partially Supported ASA with FPS Configurations

The Secure Firewall migration tool partially supports the followingASAwith FPS configurations for migration.
Some of these configurations include rules with advanced options that are migrated without those options. If
the management center supports those advanced options, you can configure themmanually after the migration
is complete.

• Access control policy rules that are configured with advanced logging settings, such as severity and
time-interval.

• Static routes that are configured with the track option.

• Certificate-based VPN migration.

• Dynamic-Route Objects, EIGRP, and BGP

• Route-Map

Unsupported ASA with FPS Configurations

The Secure Firewall migration tool does not support the following ASAwith FPS configurations for migration.
If these configurations are supported in the management center, you can configure them manually after the
migration is complete.

• SGT-based access control policy rules

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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• SGT-based objects

• User-based access control policy rules

• NAT rules that are configured with the block allocation option

• Objects with an unsupported ICMP type and code

• Tunneling protocol-based access control policy rules

Support with a prefilter on Secure Firewall migration tool and management center
6.5.

Note

• NAT rules that are configured with SCTP

• NAT rules that are configured with host ‘0.0.0.0’

• Default route obtained through DHCP or PPPoE with SLA tracking

• SLA monitor schedule

• Transport mode IPsec transform-set

• ASA trustpoint migration into management center

• User-based FPS ACLs, are not supported for migration and are migrated as disabled.

• Transparent firewall mode for BGP

Guidelines and Limitations
During conversion, the Secure Firewall migration tool creates a one-to-one mapping for all supported objects
and rules, whether they are used in a rule or policy. The Secure Firewall migration tool provides an optimization
feature that allows you to exclude migration of unused objects (objects that are not referenced in any ACLs
and NATs).

The Secure Firewall migration tool deals with unsupported objects and rules as follows:

• Unsupported objects and NAT rules are not migrated.

• Unsupported ACL rules are migrated as disabled rules into the management center.

• Outbound ACLs are unsupported and will not be migrated to management center. If the source firewall
has outbound ACLs, it will be reported in the ignored section of the Pre-Migration Report.

• All supported ASA with FPS crypto map VPN will be migrated as management center point-to-point
topology.

• Unsupported or incomplete static crypto map VPN topologies are not migrated.

• User-based FPS ACLs, are not supported for migration and are migrated as disabled.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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ASA with FPS Configuration Limitations

Migration of your source ASA with FPS configuration has the following limitations:

• The Secure Firewall migration tool supports migrating individual security contexts from the ASA with
FPS as separate threat defense devices.

• The system configuration is not migrated.

• The Secure Firewall migration tool does not support migration of a single ACL policy that is applied to
over 50 interfaces. Manually migrate ACL policies that are applied to 50 or more interfaces.

• You cannot migrate some ASAwith FPS configurations, for example, dynamic routing to threat defense.
Migrate these configurations manually.

• You cannot migrate ASAwith FPS devices in routedmode with a bridge virtual interface (BVI), redundant
interface, or tunneled interface. However, you can migrate ASA with FPS devices in transparent mode
with BVI.

• Nested service object-groups or port groups are not supported on the management center. As part of
conversion, the Secure Firewall migration tool expands the content of the referenced nested object-group
or port group.

• The Secure Firewall migration tool splits the extended service object or groups with source and destination
ports that are in one line into different objects across multiple lines. References to such access control
rules are converted into management center rules with the exact same meaning.

• If the source ASA with FPS configuration has access control rules that do not refer to specific tunneling
protocols (like GRE, IP-in-IP and IPv6-in-IP), but these rules match unencrypted tunnel traffic on the
ASA with FPS, then, on migration to the threat defense, the corresponding rules will not behave in the
same way they do on the ASA with FPS. We recommend that you create specific tunnel rules for these
in the Prefilter policy, on the threat defense.

• Supported ASA with FPS crypto map will be migrated as point-to-point topology.

• If an AS-Path object with the same name in management center appears, then the migration stops with
the following error message:

"Conflicting AS-Path object name detected in management center, please resolve conflict in management
center to proceed further"

• Redistribution from OSPF and Routing Information Protocol (RIP) into EIGRP is not supported.

Limitations for RA VPN Migration

Remote Access VPN migration is supported with the following limitations:

• SSL settings migration is not supported due to API limitations.

• LDAP server is migrated with encryption type as "none".

• DfltGrpPolicy is not migrated as the policy is applicable for the entire management center. You can make
the necessary changes directly on the management center.

• For a radius server, if dynamic authorization is enabled, the AAA server connectivity should be through
an interface and not dynamic routing. If ASA with FirePOWER Services configuration is found with
AAA server with dynamic authorization enabled without interface, the Secure Firewall migration tool
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ignores dynamic authorization. You must enable dynamic-authorization manually after selecting an
interface on the management center.

• ASA with FirePOWER Services configuration can have an interface while calling address pool under
tunnel-group. But the same is not supported on the management center. If there an interface is detected
in the ASA with FirePOWER Services configuration it is ignored by the Secure Firewall migration tool
and the address pool is migrated without the interface.

• ASA with FirePOWER Services configuration can have keyword link-selection/subnet-selection for
dhcp-server under tunnel group. But the same is not supported on the management center. If a dhcp server
is detected in the ASA with FirePOWER Services configuration with these keywords, it is ignored by
the Secure Firewall migration tool and the dhcp-server is pushed without the keywords.

• ASA with FirePOWER Services configuration can have an interface while calling authentication server
group, secondary authentication server group, authorization server group under tunnel group. But the
same is not supported on the management center. If an interface is detected in the ASAwith FirePOWER
Services configuration it is ignored by the Secure Firewall migration tool and the commands are pushed
without the interface.

• ASAwith FirePOWERServices configuration does not map Redirect ACL to a radius server. Thus, there
is no way to retrieve it from the Secure Firewall migration tool. If redirect ACL is used in the ASA with
FirePOWER Services, it is left empty, and you must add and map it manually on the management center.

• ASA with FirePOWER Services supports value from 0-720 for vpn-addr-assign local reuse delay. But
the management center supports value from 0-480. If a value higher than 480 is found in the ASA with
FirePOWERServices configuration, it is set to maximum supported value 480 on the management center.

• Configuring IPv4 pool and DHCP useSecondaryUsernameforSession settings to the connection profile
is not supported due to API issues.

• Bypass access control sysopt permit-vpn option is not enabled under RA VPN policy. However, if
required, you can enable it from the management center.

• AnyConnect client module and profile values can be updated under group policy only when the profiles
are uploaded from Secure Firewall migration tool to the management center.

• You need to map the certificates directly on the management center.

• IKEv2 parameters are not migrated by default. You must add them through the management center.

Firewall Services (FPS) Migration Guidelines

The Secure Firewall migration tool uses best practices for threat defense configurations, including the following:

• The migration of the ACL log option follows the best practices for threat defense. The log option for a
rule is enabled or disabled based on the source ASA with FPS configuration. For rules with an action of
deny, the Secure Firewall migration tool configures logging at the beginning of the connection. If the
action is permit, the Secure Firewall migration tool configures logging at the end of the connection.

• The ASA with FPS rules are migrated as follows:

ASA with FPS redirection ACLs are migrated as prefilter rules (conditional).

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
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You can migrate the FPS rules using the Secure Firewall migration tool only if
the FPS module is managed through management center.

Note

• If the source redirection ACL has Action=DENY—migrated as management center Prefilter rule
withAction=Fastpath. Also, this particular ACL is positioned as the first ACL rule in DISABLED
state.

• If the source redirection ACL has Action=Permit—will not be migrated by the Secure Firewall
migration tool.

Object Migration Guidelines

ASA with FPS and threat defense have different configuration guidelines for objects. For example, one or
more objects can have the same name in ASA with FPS with one object name in lowercase and the other
object name in uppercase, but each object must have a unique name, regardless of case, in threat defense. To
accommodate such differences, the Secure Firewall migration tool analyzes all ASA with FPS objects and
handles their migration in one of the following ways:

• Each ASA with FPS object has a unique name and configuration—The Secure Firewall migration tool
migrates the objects successfully without changes.

• The name of an ASA with FPS object includes one or more special characters that are not supported by
the management center—The Secure Firewall migration tool renames the special characters in the object
name with a "_" character to meet the Management Center object naming criteria.

• An ASA with FPS object has the same name and configuration as an existing object in the management
center—The Secure Firewall migration tool reuses the Secure Firewall Management Center object for
the Secure Firewall Threat Defense configuration and does not migrate the ASA with FPS object.

• An ASA with FPS object has the same name but a different configuration than an existing object in
Secure Firewall Management Center—The Secure Firewall migration tool reports object conflict and
allows you to resolve the conflict by adding a unique suffix to the name of the ASA with FPS object for
migration purposes.

• Multiple ASAwith FPS objects have the same name but in different cases—The Secure Firewall migration
tool renames such objects to meet the Secure Firewall Threat Defense object naming criteria.

The Secure Firewall migration tool analyzes both name and configuration of all objects and object groups.
However, XML profiles in remote-access VPN configurations are analyzed only using the name.

Important

The Secure Firewall migration tool supports discontiguous network mask (Wildcard mask) objects migration
if the destination Firewall Management Center is 7.1 or later.

Note

ASA example:
object network wildcard2
subnet 2.0.0.2 255.0.0.255
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Guidelines and Limitations for Threat Defense Devices

As you plan to migrate your ASA with FPS configuration to threat defense, consider the following guidelines
and limitations:

• If there are any existing device-specific configurations on the threat defense such as routes, interfaces,
and so on, during the push migration, the Secure Firewall migration tool cleans the device automatically
and overwrites from the ASA with FPS configuration.

To prevent any undesirable loss of device (target threat defense) configuration
data, we recommend you to manually clean the device before migration.

Note

During migration, the Secure Firewall migration tool resets the interface configuration. If you use these
interfaces in policies, the Secure Firewall migration tool cannot reset them and hence the migration fails.

• The Secure Firewall migration tool can create subinterfaces on the native instance of the threat defense
device based on the ASA with FPS configuration. Manually create interfaces and port channel interfaces
on the target threat defense device before starting migration. For example, if your ASA with FPS
configuration is assigned with the following interfaces and port channels, you must create them on the
target threat defense device before the migration:

• Five physical interfaces

• Five port channels

• Two management-only interfaces

For container instances of threat defense devices, subinterfaces are not created
by the Secure Firewall migration tool, only interface mapping is allowed.

Note

• The Secure Firewall migration tool can create subinterfaces and Bridge-Group Virtual Interfaces
(transparent mode) on the native instance of the threat defense device that is based on the ASA with FPS
configuration. Manually create interfaces and port channel interfaces on the target threat defense device
before startingmigration. For example, if your ASAwith FPS configuration is assigned with the following
interfaces and port channels, youmust create them on the target threat defense device before the migration:

• Five physical interfaces

• Five port channels

• Two management-only interfaces

For container instances of threat defense devices, subinterfaces are not created
by the Secure Firewall migration tool, only interface mapping is allowed.

Note
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Supported Platforms for Migration
The following ASAwith FPS and threat defense platforms are supported for migration with the Secure Firewall
migration tool. For more information about the supported threat defense platforms, see Cisco Secure Firewall
Compatibility Guide.

The Secure Firewall migration tool supports migration of standalone ASA with FPS devices to a standalone
threat defense device only.

Note

Supported Source ASA models for ASA with FPS migration:

The Cisco ASA FirePOWER module is deployed on the following devices:

• ASA5506-X

• ASA5506H-X

• ASA5506W-X

• ASA5508-X

• ASA5512-X

• ASA5515-X

• ASA5516-X

• ASA5525-X

• ASA5545-X

• ASA5555-X

• ASA5585-X-SSP-10

• ASA5585-X-SSP-20

• ASA5585-X-SSP-40

• ASA5585-X-SSP-60

Supported Target Threat Defense Platforms

You can use the Secure Firewall migration tool to migrate a source ASA with FPS configuration to the
following standalone or container instance of the threat defense platforms:

• Firepower 1000 Series

• Firepower 2100 Series

• Secure Firewall 3100 Series

• Firepower 4100 Series

• Firepower 9300 Series that includes:
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• SM-24

• SM-36

• SM-40

• SM-44

• SM-48

• SM-56

• Threat Defense on VMware, deployed using VMware ESXi, VMware vSphere Web Client, or vSphere
standalone client

• Threat Defense Virtual on Microsoft Azure Cloud or AWS Cloud

• For pre-requisites and pre-staging of threat defense virtual in Azure, see
Getting Started with Secure Firewall Threat Defense Virtual and Azure.

• For pre-requisites and pre-staging of threat defense virtual in AWS Cloud,
see Threat Defense Virtual Prerequisites.

Note

For each of these environments, once pre-staged as per the requirements, the Secure Firewall migration
tool requires network connectivity to connect to the management center in Microsoft Azure or AWS
Cloud, and then migrate the configuration to the management center in the Cloud.

The pre-requisites of pre-staging the management center or threat defense virtual
is required to be completed before using the Secure Firewall migration tool, to
have a successful migration.

Note

The Secure Firewall migration tool requires network connectivity to any devices
hosted in the cloud to migrate the manually uploaded configuration to the
management center in the cloud. Hence, as a pre-requisite, IP network connectivity
is required to be pre-staged before using the Secure Firewall migration tool.

Note

Supported Target Management Center for Migration
The Secure Firewall migration tool supports migration to threat defense devices managed by the management
center and cloud-delivered Firewall Management Center.
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Management Center

Themanagement center is a powerful, web-based, multi-device manager that runs on its own server hardware,
or as a virtual device on a hypervisor. You can use both On-Prem and Virtual management center as a target
management center for migration.

The management center should meet the following guidelines for migration:

• The Management Center software version that is supported for migration, as described in Supported
Software Versions for Migration, on page 19.

• You have obtained and installed smart licenses for threat defense that include all features that you plan
to migrate from the ASA with FPS interface, as described in the following:

• The Getting Started section of Cisco Smart Accounts on Cisco.com.

• Register the Firewall Management Center with the Cisco Smart Software Manager.

• Licensing the Firewall System

• You have enabled management center for REST API.

On the management center web interface, navigate to System > Configuration > Rest API
Preferences > Enable Rest API and check the Enable Rest API check box.

You need to have an administrator user role in management center to enable
REST API. For more information on management center user roles, see User
Roles.

Important

Supported Software Versions for Migration
The following are the supported Secure Firewall migration tool, ASA with FPS and threat defense versions
for migration:

Supported Secure Firewall Migration Tool Versions

The versions posted on software.cisco.com are the versions formally supported by our engineering and support
organizations. We strongly recommend you download the latest version of Secure Firewall migration tool
from software.cisco.com.

Supported ASA with FPS Versions

The Secure Firewall migration tool supports migration from a device that is running ASA with FPS software
version 9.2.2+ and later.

For more details, see ASA FirePOWERModule Compatibility section in the Cisco ASACompatibility guide.

Supported Management Center Versions for source ASA with FPS Configuration

For ASA with FPS, the Firewall Migration Tool supports migration to a threat defense device managed by a
management center that is running version 6.5+.
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Supported Threat Defense Versions

The Secure Firewall migration tool recommends migration to a device that is running threat defense version
6.5 and later.

For detailed information about the Cisco Firewall software and hardware compatibility, including operating
system and hosting environment requirements, for threat defense, see the Cisco Firewall Compatibility Guide.
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C H A P T E R 2
ASA with FPS to Threat Defense Migration
Workflow

• End-to-End Procedure, on page 21
• Prerequisites for Migration, on page 23
• Run the Migration, on page 26
• Uninstall the Secure Firewall Migration Tool, on page 50
• Sample Migration: ASA with FPS to Threat Defense 2100 , on page 50

End-to-End Procedure
The following flowchart illustrates the workflow for migrating an ASA with FPS to threat defense using the
Secure Firewall migration tool.

StepsWorkspace

Download the latest version of Secure Firewall migration tool fromCisco.com.
For detailed steps, see Download the Secure Firewall Migration Tool from
Cisco.com.

Local Machine
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StepsWorkspace

(Optional) Obtain the ASA with FPS configuration file: To obtain the ASA
with FPS config file from ASA CLI, see Obtain the ASA with FPS
Configuration File. If you intend to connect the ASA from Secure Firewall
migration tool, skip to step 3.

ASA CLI

(Optional) Export PKI certificates from ASA CLI: This step is required only
if you are planning to migrate site-to site VPN and RA VPN features from
ASA to threat defense. To export the PKI certificates from ASA CLI, see
Export PKI Certificate fromASAwith FirePOWERServices and Import into
Management Center. If you are not planning to migrate site-to-site VPN and
RA VPN, skip to step 7.

ASA CLI

(Optional) Export AnyConnect packages and profiles from ASA CLI: This
step is required only if you are planning to migrate RA VPN features from
ASAwith FPS to threat defense. To export AnyConnect packages and profiles
from ASA CLI, see Retrieve AnyConnect Packages and Profiles. If you are
not planning to migrate site-to-site VPN and RA VPN, skip to step 7.

ASA CLI

(Optional) Import the PKI certificates and Anyconnect packages to
management center: To import the PKI certificates to management center,
see Export PKI Certificate from ASAwith FirePOWER Services and Import
into Management Center and Retrieve AnyConnect Packages and Profiles.

Management Center

Launch the Secure Firewall migration tool on your local machine, see Launch
the Secure Firewall Migration Tool.

Local Machine

(Optional) Upload the ASA with FPS config file obtained from ASA CLI,
see Upload the ASA with FPS Configuration File. If you are planning to
connect to live ASA with FPS, skip to step 8.

Secure Firewall
Migration Tool

You can connect to live ASA with FPS directly from the Secure Firewall
migration tool. For more information, see Connect to the ASA from the Secure
Firewall Migration Tool.

Secure Firewall
Migration Tool

During this step, you can specify the destination parameters for the migration.
For detailed steps, see Specify Destination Parameters for the Secure Firewall
Migration Tool.

Secure Firewall
Migration Tool

Navigate to where you downloaded the postmigration report and review the
report. For detailed steps, see Review the Pre-Migration Report.

Secure Firewall
Migration Tool

The Secure Firewall migration tool allows you to map the ASA with FPS
configuration with threat defense interfaces. For detailed steps, seeMap ASA
with FPSConfigurationswith Secure Firewall DeviceManager Threat Defense
Interfaces.

Secure Firewall
Migration Tool

To ensure that the ASA with FPS configuration is migrated correctly, map
the ASAwith FPS interfaces to the appropriate threat defense interface objects,
security zones and interface groups. For detailed steps, see Map ASA with
FPS Configurations with Secure Firewall Device Manager Threat Defense
Interfaces.

Secure Firewall
Migration Tool
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StepsWorkspace

Optimize and review the configuration carefully and validate that it is correct
andmatches how you want to configure the threat defense device. For detailed
steps, see Optimize, Review and Validate the Configuration.

Secure Firewall
Migration Tool

This step in the migration process sends the migrated configuration to
management center and allows you to download the post-migration report.
For detailed steps, see Push the Migrated Configuration to Management
Center.

Secure Firewall
Migration Tool

Navigate to where you downloaded the post migration report and review the
report. For detailed steps, see Review the Post-Migration Report and Complete
the Migration.

Local Machine

Deploy the migrated configuration from the management center to threat
defense. For detailed steps, see Review the Post-Migration Report and
Complete the Migration.

Management Center

Prerequisites for Migration
Before you migrate your ASA with FPS configuration, execute the following activities:

Download the Secure Firewall Migration Tool from Cisco.com

Before you begin

You must have a Windows 10 64-bit or macOS version 10.13 or higher machine with an internet connectivity
to Cisco.com.

Step 1 On your computer, create a folder for the Secure Firewall migration tool.

We recommend that you do not store any other files in this folder. When you launch the Secure Firewall migration tool,
it places the logs, resources, and all other files in this folder.

Whenever you download the latest version of the Secure Firewall migration tool, ensure, you create a new
folder and not use the existing folder.

Note

Step 2 Browse to https://software.cisco.com/download/home/286306503/type and click Firewall Migration Tool.

The above link takes you to the Secure Firewall migration tool under Firewall NGFW Virtual. You can also download
the Secure Firewall migration tool from the threat defense device download areas.

Step 3 Download the most recent version of the Secure Firewall migration tool into the folder that you created.

Download the appropriate executable of the Secure Firewall migration tool for Windows or macOS machines.
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Obtain the ASA with FPS Configuration File
You can use one of the following methods to obtain an ASA with FPS configuration file:

• Export the ASA with FPS Configuration File, on page 24

• Connect to the ASA from the Secure Firewall Migration Tool, on page 30

Export the ASA with FPS Configuration File
This task is required only if you want to manually upload an ASA with FPS configuration file. If you want
to connect to an ASA with FPS from the Secure Firewall migration tool, skip to Connect to the ASA from
the Secure Firewall Migration Tool, on page 30.

Do not hand code or make changes to the ASAwith FPS configuration after you export the file. These changes
will not be migrated to threat defense, and they create errors in the migration or cause the migration to fail.
For example, opening and saving the configuration file in terminal can add white space or blank lines that the
Secure Firewall migration tool cannot parse.

Ensure that the exported ASA with FPS configuration file does not contain the "--More--" keyword as text,
as this can cause the migration to fail.

Note

ASA with FPS configuration file migration into the Secure Firewall migration tool is a two-step process:

• You can import the ASA configuration file using the manual method or live-connect method.

• You must import the FPS configuration file by connecting to the Firewall Management Center that
manages the FPS, and by selecting the required source ACL policy that must be migrated.

Step 1 Use the show running-config command for the ASA device or context that you are migrating and copy the configuration
from there. See View the Running Configuration.

Alternately, use Adaptive Security Device Manager (ASDM) for the ASA device or context that you want to migrate and
choose File > Show Running Configuration in New Window to obtain the configuration file.

For a multi context ASAwith FPS, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Note

Step 2 Save the configuration as either .cfg or .txt.

You cannot upload the ASA with FPS configuration to the Secure Firewall migration tool if it has a different extension.

Step 3 Transfer the ASA with FPS configuration file to your computer where you downloaded the Secure Firewall migration
tool.

Migrating ASA with FirePOWER Services (FPS) Firewall to Secure Firewall Threat Defense with the Migration Tool
24

ASA with FPS to Threat Defense Migration Workflow
Obtain the ASA with FPS Configuration File

https://www.cisco.com/c/en/us/td/docs/security/asa/asa99/configuration/general/asa-99-general-config/ref-cli.html#ID-2118-000000c8


Export PKI Certificate from ASA with FirePOWER Services and Import into
Management Center

Before you begin

The Secure Firewall migration tool supports migration of Certificate-based VPN into the management center.

ASA with FirePOWER Services uses the trustpoint model for storing certificates in the configuration. A
trustpoint is a container in which certificates are stored. ASA with FirePOWER Services trustpoint can store
up to two certificates.

The ASA with FirePOWER Services trustpoint or certificates in the ASA with FirePOWER Services
configuration file contains hash values. Hence, you cannot directly import them into a management center.

In the destination management center, migrate the ASA with FirePOWER Services trustpoint or the VPN
certificates manually as PKI objects as part of the pre-migration activity.

Step 1 Use the following command to export the PKI certificate through the CLI from the source ASAwith FirePOWERServices
config with the keys to a PKCS12 file.
ASA(config)#crypto ca export <trust-point-name> pkcs12 <passphrase>

Step 2 Import the PKI certificate into a management center (Object Management PKI Objects).

For more information, see Firewall Management Center Configuration Guide.

The manually created PKI objects can now be used in the Secure Firewall migration tool in the Review and Validate
Page under the Trustpoint section in Remote Access VPN.

Retrieve AnyConnect Packages and Profiles
AnyConnect profiles are optional and can be uploaded through the management center or Secure Firewall
migration tool.

Before you begin

• Remote Access VPN on the management center requires at least one AnyConnect package.

• If the configuration consists of Hostscan and External Browser package, you must upload these packages.

• All packages must be added to the management center as part of the pre-migration activity.

• Dap.xml and Data.xml must be added through the Secure Firewall migration tool.

Step 1 Use the following command to copy the required package from the source ASA to an FTP or TFTP server.
Copy <source file location:/source file name> <destination>
ASA# copy disk0:/anyconnect-win-4.10.02086-webdeploy-k9.pkg tftp://1.1.1.1 <----- Example of copying
Anyconnect Package.
ASA# copy disk0:/ external-sso- 4.10.04071-webdeploy-k9.zip tftp://1.1.1.1 <----- Example of copying
External Browser Package.
ASA# copy disk0:/ hostscan_4.10.04071-k9.pkg tftp://1.1.1.1 <----- Example of copying Hostscan Package.
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ASA# copy disk0:/ dap.xml tftp://1.1.1.1. <----- Example of copying Dap.xml
ASA# copy disk0:/ sdesktop/data.xml tftp://1.1.1.1 <----- Example of copying Data.xml
ASA# copy disk0:/ VPN_Profile.xml tftp://1.1.1.1 <----- Example of copying Anyconnect Profile.

Step 2 Import the downloaded packages to management center (Object Management > VPN > AnyConnect File).

a. Dap.xml and Data.xml must be uploaded to the management center from the Secure Firewall migration tool in the
Review and Validate > Remote Access VPN > AnyConnect File section.

b. AnyConnect profiles can be uploaded directly to the management center or through the Secure Firewall migration
tool in the Review and Validate > Remote Access VPN > AnyConnect File section.

The manually uploaded files can now be used in the Secure Firewall migration tool.

Run the Migration

Launch the Secure Firewall Migration Tool
This task is applicable only if you are using the desktop version of the Secure Firewall migration tool. If you
are using the cloud version of the migration tool hosted on CDO, skip to .

When you launch the Secure Firewall migration tool a console opens in a separate window. As you go through
the migration, the console displays the progress of the current step in the Secure Firewall migration tool. If
you do not see the console on your screen, it is most likely to be behind the Secure Firewall migration tool.

Note

Before you begin

• Download the Secure Firewall Migration Tool from Cisco.com

• Review and verify the requirements in the Supported Target Management Center for Migration, on page
18 section.

• Ensure that your computer has a recent version of the Google Chrome browser to run the Secure Firewall
migration tool. For information on how to set Google Chrome as your default browser, see Set Chrome
as your default web browser.

• If you are planning to migrate a large configuration file, configure sleep settings so the system doesn’t
go to sleep during a migration push.

Step 1 On your computer, navigate to the folder where you downloaded the Secure Firewall migration tool.
Step 2 Do one of the following:

• On your Windows machine, double-click the Secure Firewall migration tool executable to launch it in a Google
Chrome browser.

If prompted, click Yes to allow the Secure Firewall migration tool to make changes to your system.
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The Secure Firewall migration tool creates and stores all related files in the folder where it resides, including the
log and resources folders.

• On your Mac move, the Secure Firewall migration tool *.command file to the desired folder, launch the Terminal
application, browse to the folder where the Secure Firewall migration tool is installed and run the following
commands:

# chmod 750 Firewall_Migration_Tool-version_number.command

# ./Firewall_Migration_Tool-version_number.command

The Secure Firewall migration tool creates and stores all related files in the folder where it resides, including the
log and resources folders.

When you try to open the Secure Firewall migration tool, you get a warning dialog because the Secure
Firewall migration tool is not registered with Apple by an identified developer. For information on
opening an application from an unidentified developer, see Open an app from an unidentified developer.

Tip

Use MAC terminal zip method.Note

Step 3 On the End User License Agreement page, click I agree to share data with Cisco Success Network if you want to
share telemetry information with Cisco, else click I'll do later.

When you agree to send statistics to Cisco Success Network, you are prompted to log in using your Cisco.com account.
Local credentials are used to log in to the Secure Firewall migration tool if you choose not to send statistics to Cisco
Success Network.

Step 4 On the Secure Firewall migration tool's login page, do one of the following:

• To share statistics with Cisco Success Network, click theLogin with CCO link to log in to your Cisco.com account
using your single sign-on credentials. If you do not have a Cisco.com account, create it on the Cisco.com login
page.

Proceed to step 8, if you have used your Cisco.com account to log in.

• If you have deployed your firewall in an air-gapped network that does not have internet access, contact Cisco TAC
to receive a build that works with administrator credentials. Note that this build does not send usage statistics to
Cisco, and TAC can provide you the credentials.

Step 5 On the Reset Password page, enter the old password, your new password, and confirm the new password.

The new password must have 8 characters or more and must include upper and lowercase letters, numbers, and special
characters.

Step 6 Click Reset.
Step 7 Log in with the new password.

If you have forgotten the password, delete all the existing data from the <migration_tool_folder> and
reinstall the Secure Firewall migration tool.

Note

Step 8 Review the pre-migration checklist and make sure you have completed all the items listed.

If you have not completed one or more of the items in the checklist, do not continue until you have done so.

Step 9 Click New Migration.
Step 10 On the Software Update Check screen, if you are not sure you are running the most recent version of the Secure

Firewall migration tool, click the link to verify the version on Cisco.com.
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Step 11 Click Proceed.

What to do next

You can proceed to the following step:

• If you have exported ASA with FPS configuration to your computer, proceed to Upload the ASA with
FPS Configuration File.

• If you want to extract information from an ASA with FPS using the Secure Firewall migration tool,
proceed to Connect to the ASA from the Secure Firewall Migration Tool, on page 30

Using the Demo Mode in Firewall Migration Tool
When you launch the Secure Firewall Migration tool and are on the Select Source Configuration page, you
can choose to start performing a migration using Start Migration or enter the Demo Mode.

This feature is applicable only if you are using the desktop version of Secure Firewall migration tool.Note

The demo mode provides an opportunity to try performing a demo migration using dummy devices, and
visualize how an actual migration flow would look like. The migration tool triggers the demo mode based on
the selection you make in the Source Firewall Vendor drop-down; you can also upload a configuration file
or connect to a live device and continue with the migration. You can proceed performing the demo migration
by selecting demo source and target devices such as demo FMC and demo FTD devices.

Choosing Demo Mode erases any existing migration workflows. If you use the demo mode while you have
an active migration in Resume Migration, your active migration is lost and needs to be restarted from first,
after you use the demo mode.

Caution

You can also download and verify the pre-migration report, map interfaces, map security zones, map interface
groups, and perform all other actions like you would in an actual migration workflow. However, you can only
perform a demo migration up to validation of the configurations. Because this is only a demo mode of the
migration tool, you cannot push the configurations to the demo target devices you selected. You can verify
the validation status and the summary and click Exit Demo Mode to go the Select Source Configuration
page again to start your actual migration.
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The demo mode lets you leverage the whole feature set of the Secure Firewall Migration Tool, except pushing
of configurations, and do a trial run of the end-to-end migration procedure before performing your actual
migration.

Note

Upload the ASA with FPS Configuration File

Before you begin

Export the configuration file as .cfg or .txt from the source ASA with FPS device.

Do not upload a hand coded or manually altered configuration file. Text editors add blank lines and other
issues to the file that can cause the migration to fail.

Note

Step 1 On the Extract Cisco ASA (9.2.2+) with FPS Information screen in the Manual Upload section, click Upload to
upload the ASA with FPS Configuration file.

Step 2 Browse to where the ASA with FPS configuration file is located and click Open.

The Secure Firewall migration tool uploads the configuration file. For large configuration files, this step takes a longer
time. The console provides a line by line log view of the progress, including the ASA with FPS configuration line that
is being parsed. If you do not see the console, you can find it in a separate window behind the Secure Firewall migration
tool. The Context Selection section identifies if the uploaded configuration corresponds to the multi-context .

Step 3 In the Firewall Management Center IP Address/Hostname field, enter the relevant details:

• Single context ASA with FPS—Management IP address or hostname

• Multi-context ASA with FPS—IP address of the admin context or hostname

Step 4 Click Connect.
Enter the following details in the Firewall Management Center Login screen.

• Username

• Password

• Click Login to connect to Firewall Management Center.

Step 5 The Select FPS Device drop-down, shows a list of FPS devices that is attached to the particular management center.
Each device shows the device name with the associated ACL Policy.

Step 6 Review the Context Selection section and select the ASA with FPS context that you want to migrate.
Step 7 Click Proceed.

The access rules is fetched from the device.

Step 8 Click Start Parsing.

The Parsed Summary section displays the parsing status.
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Step 9 Review the summary of the elements in the uploaded configuration file that the Secure Firewall migration tool detected
and parsed.

Step 10 Click Next to select the target parameters.

What to do next

Specify Destination Parameters for the Secure Firewall Migration Tool, on page 31

Connect to the ASA from the Secure Firewall Migration Tool
The Secure Firewall migration tool can connect to an device that you want to migrate and extract the required
configuration information.

Before you begin

• Download and launch the Secure Firewall migration tool.

• For single context ASA, obtain the management IP address, administrator credentials, and the enable
password.

• For multi-context mode ASA, obtain the IP address of the admin context, administrator credentials, and
the enable password.

If ASA is not configured with Enable Password, you can leave the field blank
on the Secure Firewall migration tool.

Note

Step 1 On the Extract Cisco ASA (9.2.2+) with FPS Information screen, in the Connect to ASA section, click Connect to
connect to the ASA device that you want to migrate.

Step 2 On the ASA Login screen, enter the following information:

a. In the ASA IP Address/Hostname field, enter the management IP address or hostname (for single context ASA)
or IP address of the admin context or hostname (for a multi-context ASA).

b. In the Username, Password, and Enable Password fields enter the appropriate administrator login credentials.

If ASA is not configured with anEnable password, you can leave the field blank on the Secure Firewall
migration tool.

Note

c. Click Login.

When the Secure Firewall migration tool connects to the ASA, it displays a successfully connected to the ASAmessage.
For a multi-context ASA, the Secure Firewall migration tool identifies and lists the contexts.

Step 3 Select the context that you want to migrate from the Context drop-down list.
Step 4 (Optional) Select Collect Hitcounts.
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When checked, this tool computes the number of times an ASA rule was used and the last time the rule was used since
ASA uptime or last ASA restart and displays this information on the Review and Validate page. This allows you to
evaluate the efficacy and relevance of the rule before migration.

Step 5 Click Start Extraction.

The Secure Firewall migration tool connects to the ASA and starts extracting configuration information. When the
extraction completes successfully, the Context Selection section identifies if the uploaded configuration corresponds
to a single-context or multi-context ASA.

Step 6 Review the Context Selection section and select the ASA context that you want to migrate.
Step 7 In the Firewall Management Center IP Address/Hostname field, enter the relevant details:

• Single context ASA with FPS—Management IP address or hostname

• Multi-context ASA with FPS—IP address of the admin context or hostname

Step 8 Click Connect.
Enter the following details in the Firewall Management Center Login screen:

• Username

• Password

• Click Login to connect to Firewall Management Center.

Step 9 The Select FPS Device drop-down, shows a list of FPS devices that is attached to the particular management center.
Each device shows the device name with the associated ACL Policy.

Step 10 Click Proceed.

The access rules is fetched from the device.

Step 11 The Parsed Summary section displays the parsing status. The Secure Firewall migration tool parses the configuration
file and disconnects from the ASA.

Step 12 Review the summary of the elements that the Secure Firewall migration tool detected and parsed in the uploaded
configuration file.

Step 13 Click Next to select the target parameters.

What to do next

Specify Destination Parameters for the Secure Firewall Migration Tool, on page 31

Specify Destination Parameters for the Secure Firewall Migration Tool

Before you begin

• Obtain the IP address for the management center for On-Prem Firewall Management Center.

• Create a dedicated account for the Secure Firewall migration tool in the management center with sufficient
privileges to access the REST API, as described in User Accounts for Management Access.
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• (Optional) If you want to migrate device-specific configurations like interfaces and routes, add the target
threat defense to the management center. See Adding Devices to the Firewall Management Center

• If it requires you to apply IPS or file policy to ACL in the Review and Validate page, we highly
recommend you create a policy on the management center before migration. Use the same policy, as the
Secure Firewall migration tool fetches the policy from the connected management center. Creating a
new policy and assigning it to multiple access control lists may degrade the performance and may also
result in a push failure.

Step 1 On the Select Target screen, in the Firewall Management section, do the following:
a) Click the On-Prem FMC radio button.
b) Enter the IP address or Fully-Qualified Domain Name (FQDN) for the management center.
c) In the Domain drop-down list, select the domain to which you are migrating.

If you want to migrate to a threat defense device, you can only migrate to the threat defense devices available in
the selected domain.

d) Click Connect and proceed to Step 2.

Step 2 In the Firewall Management Center Login dialog box, enter the username and password of the dedicated account
for the Secure Firewall migration tool, and click Login.

The Secure Firewall migration tool logs in to the management center and retrieves a list of threat defense devices that
are managed by that management center. You can view the progress of this step in the console.

Step 3 On the Select Target screen, in the Choose Threat Defense section, you can either select a threat defense device that
you want to migrate to, or if you do not have a threat defense device, you can migrate the shared policies (Access
Control Lists, NAT, and Objects) of the ASA with FPS configuration to the management center.

Step 4 In the Choose Threat Defense section, do one of the following:

• Click the Select Firewall Threat Defense Device drop-down list and check the device where you want to migrate
the ASA with FPS configuration.

The devices in the selected management center domain are listed by IP Address and Name.

At minimum, the native threat defense device you choose must have the same number of physical or
port channel interfaces as the ASA with FPS configuration that you are migrating. At minimum, the
container instance of the threat defense device must have the same number of physical or port channel
interfaces and subinterfaces. You must configure the device with the same firewall mode as the ASA
with FPS configuration. However, these interfaces do not have to have the same names on both devices.

Note

Only when the supported target threat defense platform is Firewall 1010 with management center
version 6.5 or later.6.5, FDM 5505 migration support is applicable for shared policies and not for
device specific policies. When you proceed without threat defense, the Secure Firewall migration tool
will not push any configurations or the policies to the threat defense. Thus, interfaces and routes, and
site-to-site VPNwhich are threat defense device-specific configurations will not be migrated. However,
all the other supported configurations (shared policies and objects) such as NAT, ACLs, and port
objects will be migrated. Remote Access VPN is a shared policy and can be migrated even without
threat defense.

Note
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Table 1: ASA with FPS Firewall Features and Supported Management Center or Threat Defense Versions

Supported Management Center or Threat Defense
Version

Firewall Features

6.7 or laterASA with FPS with remote deployment

6.6 or laterCrypto Map Site-to-Site VPN

6.7 or laterVirtual Tunnel Interface (VTI) and Route-based (VTI)

6.5 or laterASA with FPS deployment

7.1 or laterDynamic-Route Objects and BGP

• Management Center 7.2 or later

• Threat Defense 7.0 or later.

Remote Access VPN

• Management Center 7.2 or later

• Threat Defense 7.0 or later.

EIGRP

Tomigrate Site-to-Site VPN, VTI, and Route-based (VTI) interfaces, threat defensemust be configured
on management center.

Note

• For ASA 5505, the device-specific configs (Interface and routes) and shared policies (NAT, ACLs, and Objects)
can be migrated only when the supported target threat defense platform is Firewall 1010 with management center
version 6.5 or later.

• If the target threat defense is not FPR-1010 or the target management center is earlier than 6.5,
ASA 5505 migration support is applicable for shared policies only. Device specifics will not be
migrated.

• You can select only FPR-1010 in the Select Device drop-down list as the source config is ASA
5505.

• ASA-SM migration support is for shared policies only. Device specifics will not be migrated.

Note

• Click Proceed without FTD to migrate the configuration to the management center.

When you proceed without threat defense, the Secure Firewall migration tool will not push any configurations or
the policies to threat defense. Thus, interfaces and routes, and site-to-site VPN which are threat defense
device-specific configurations will not be migrated and need to be manually configured on management center.
However, all the other supported configurations (shared policies and objects) such as NAT, ACLs, and port objects
will be migrated. Remote Access VPN is a shared policy and can be migrated even without threat defense.

Step 5 Click Proceed.

Depending on the destination that you are migrating to, the Secure Firewall migration tool allows you to select the
features that you want to migrate.

Step 6 Click the Select Features section to review and select the features that you want to migrate to the destination.
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• If you are migrating to a destination threat defense device, the Secure Firewall migration tool automatically selects
the features available for migration from the ASAwith FPS configuration in theDevice Configuration and Shared
Configuration sections. You can further modify the default selection, according to your requirements.

• If you are migrating to a management center, the Secure Firewall migration tool automatically selects the features
available for migration from the ASA with FPS configuration in the Shared Configuration section. You can
further modify the default selection, according to your requirements.

The Device Configuration section is not available when you have not selected a destination threat
defense device to migrate to.

Note

The Device Configuration section is not available when you have selected Migrate Firepower
Device Manager (Shared Configurations Only).

Note

• The Secure Firewall migration tool supports the following for access control during migration:

• Populate Destination Security Zones—Enables mapping of destination zones for the ACL during migration.

Route-lookup logic is limited to Static Routes and Connected Routes, and PBR, Dynamic Routes, and NAT
are not considered. Interface network configuration is used to derive the connected route information.

Based on the nature of Source and Destination network object-groups, this operation may result in rule
explosion.

• Migrate unencrypted tunnels rules (ASA) as prefilter policy—Mapping of ASA encapsulated tunnel protocol
rule to Prefilter tunnel rules and has the following advantages:

• Tailor Deep Inspection—For encapsulated traffic and to improve performance with fastpathing.

• Improve Performance—You can fastpath or block any other connections that benefit from early handling.

The Secure Firewall migration tool identifies the encapsulated tunnel traffic rules in source configuration
and migrates them as Prefilter tunnel rules. You can verify the migrated tunnel rule under the Prefilter policy.
The Prefilter policy is associated with the migrated access control policy on management center.

The protocols which are migrated as Prefilter tunnel rules are following:

• GRE (47)

• IPv4 encapsulation (4)

• IPv6 encapsulation (41)

• Teredo Tunneling (UDP:3544)

If you do not opt to select the prefilter option, all the tunneled traffic rules will be migrated as
unsupported rules.

Note

The ACL tunnel rules (GRE and IPnIP) in the ASA with FPS configuration are currently migrated as
bidirectional by default. You can now specify the Rule direction for the destination as bidirectional or
unidirectional in the access control state option.

• The Secure Firewall migration tool supports the following interfaces and objects for VPN Tunnel migration:

• Policy-based (Crypto Map)—If the target management center and threat defense is version 6.6 or later.

• Route-based (VTI)—If the target management center and threat defense is version 6.7 or later.
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• The Secure Firewall migration tool supports migration of Remote Access VPN if the target management center
is 7.2 or later. Remote Access VPN is a shared policy that can be migrated without threat defense. If migration is
selected with threat defense, the threat defense version should be 7.0 or later.

• (Optional) In the Optimization section, select Migrate only referenced objects to migrate only those objects
that are referenced in an access control policy and a NAT policy.

When you select this option, unreferenced objects in the ASA with FPS configuration will not be
migrated. This optimizes migration time and cleans out unused objects from the configuration.

Note

• (Optional) In the Optimization section, select Object group search for optimal memory utilization by access
policy on threat defense.

• (Optional) In the Inline Grouping section, the Secure Firewall migration tool allows you to clear the access rules
of the pre-defined network and service object names that start with CSM or DM. If you uncheck this option, the
pre-defined object names will be retained during migration. For more information, see Inline Grouping.

By default, the option of Inline Grouping is enabled.Note

Step 7 Click Proceed.
Step 8 Click Start Conversion to initiate the conversion.
Step 9 In the Rule Conversion/ Process Config section, click Start Conversion to initiate the conversion.
Step 10 Review the summary of the elements that the Secure Firewall migration tool converted.

To check whether your configuration file is successfully uploaded and parsed, download and verify the Pre-Migration
Report before you continue with the migration.

Step 11 Click Download Report and save the Pre-Migration Report.

A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the Secure Firewall
migration tool.

What to do next

Review the Pre-Migration Report, on page 36

Inline Grouping

Object Grouping by ASDM and CSM Managed ASA

When you enter more than one item (object or inline values) in the source or destination address, or source
or destination service, CSM or ASDM automatically creates an object group. The naming conventions for
these object groups that are used by CSM and ASDM are CSM_INLINE and DM_INLINE respectively while
deploying the configuration on to respective ASA device.

To change the behavior of the object grouping from Tools > Preferences, choose Auto-expand network
and service objects with specified prefix rule table preference.

Note

The following is the configuration snippet extracted using the show run command on ASA managed by
ASDM.
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object network host1
host 10.1.1.100
object network fqdn_obj1
fqdn abc.cisco.com
object-group network DM_INLINE_NETWORK_1
network-object 10.21.44.189 255.255.255.255
network-object 10.21.44.190 255.255.255.255
object-group network DM_INLINE_NETWORK_2
network-object 10.21.44.191 255.255.255.255
network-object object host1
network-object object fqdn_obj1

access-list CSM_DM_ACL extended permit tcp object-group DM_INLINE_NETWORK_1 object-group
DM_INLINE_NETWORK_2

In the above example, access-list CSM_DM_ACL on ASDMUI does not show DM_INLINE group as rule’s
Source and Destination network instead displays contents of DM_INLINE group.

Inline Grouping—ASDM/CSM

The Inline Grouping functionality of the Secure Firewall migration tool allows you to parse show
running-configuration of ASDM or CSMmanaged ASA devices. It provides an option to preserve the same
UI representation of the access-list rules as on ASDM or CSM. If opted out, migrated rules will refer to
DM_INLINE groups as recorded in ASA show running-configuration.

The source ASA configuration file input to the Secure Firewall migration tool would still be show run or
show tech collected from ASA or via live connection to ASA device (SSH). The Secure Firewall migration
tool does not support any other form of configuration files or methods.

Note

The following figures show how the Source and Destination Network fields of ACE or RULE change based
on the enabling or disabling the inline grouping option respectively.

Figure 1: With Inline Grouping—ASDM/CSM Enabled

Figure 2: With Inline Grouping—ASDM/CSM Disabled

Review the Pre-Migration Report
If you havemissed to download the Pre-Migration Reports duringmigration, use the following link to download:

Pre-Migration Report Download Endpoint—http://localhost:8888/api/downloads/pre_migration_summary_
html_format
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You can download the reports only when the Secure Firewall migration tool is running.Note

Step 1 Navigate to where you downloaded the Pre-Migration Report.

A copy of the Pre-Migration Report is also saved in the Resources folder in the same location as the Secure Firewall
migration tool.

Step 2 Open the Pre-Migration Report and carefully review its contents to identify any issues that can cause the migration to
fail.

The Pre-Migration Report includes the following information:

• Overall Summary—The method used to extract the ASA with FPS configuration information or manual upload
for ASA with FPS.

If connecting to a live ASA, the firewall mode detected on the ASA with FPS, and for multiple context mode, the
context you chose for migration.

A summary of the supported ASA with FPS configuration elements that can be successfully migrated to threat
defense and specific ASA with FPS features selected for migration.

While connecting to a live ASA, the summary includes the hit count information- the number of times an ASA rule
was encountered and its time-stamp information.

• Configuration Lines with Errors—Details of ASA with FPS configuration elements that cannot be successfully
migrated because the Secure Firewall migration tool could not parse them. Correct these errors on the ASA with
FPS configuration, export a new configuration file, and then upload the new configuration file to the Secure Firewall
migration tool before proceeding.

• Partially Supported Configuration—Details of ASA with FPS configuration elements that can be only partially
migrated. These configuration elements include rules and objects with advanced options where the rule or the object
can be migrated without the advanced options. Review these lines, verify whether the advanced options are supported
in management center, and if so, plan to configure those options manually after you complete the migration with
the Secure Firewall migration tool.

• Unsupported Configuration—Details of ASA with FPS configuration elements that cannot be migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines, verify whether
each feature is supported in management center, and if so, plan to configure the features manually after you complete
the migration with the Secure Firewall migration tool.

• Ignored Configuration—Details of ASA with FPS configuration elements that are ignored because they are not
supported by the management center or the Secure Firewall migration tool. The Secure Firewall migration tool does
not parse these lines. Review these lines, verify whether each feature is supported in management center, and if so,
plan to configure the features manually.

For more information about supported features in management center and threat defense, see Management Center
Configuration Guide.

Step 3 If the Pre-Migration Report recommends corrective actions, complete those corrections on the ASAwith FPS interface,
export the ASA with FPS configuration file again and upload the updated configuration file before proceeding.
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Step 4 After your ASA with FPS configuration file is successfully uploaded and parsed, return to the Secure Firewall migration
tool, and click Next to continue the migration.

What to do next

Map ASA with FPS Configurations with Secure Firewall Device Manager Threat Defense Interfaces

Map ASA with FPS Configurations with Secure Firewall Device Manager
Threat Defense Interfaces

The threat defense device must have an equal or greater number of physical and port channel interfaces than
those used by ASA with FPS configuration. These interfaces do not have to have the same names on both
devices. You can choose how you want to map the interfaces.

On the Map FTD Interface screen, the Secure Firewall migration tool retrieves a list of the interfaces on the
threat defense device. By default, the Secure Firewall migration tool maps the interfaces in ASA with FPS
and the threat defense device according to their interface identities. For example, the 'management-only'
interface on the interface is automatically mapped to the 'management-only' interface on the threat defense
device and is unchangeable.

The mapping of ASA with FPS interface to the threat defense interface differs based on the threat defense
device type:

• If the target threat defense is of native type:

• The threat defense must have equal or a greater number of used ASA with FPS interfaces or port
channel (PC) data interfaces (excluding management-only and subinterfaces in the ASA with FPS
configuration). If the number is less, add the required type of interface on the target threat defense.

• Subinterfaces are created by the secure Firewall migration tool based on physical interface or port
channel mapping.

• If the target threat defense is of container type:

• The threat defense must have equal or a greater number of used ASA with FPS interfaces, physical
subinterfaces, port channel, or port channel subinterfaces (excluding management-only in ASAwith
FPS configuration). If the number is less, add the required type of interface on the target threat
defense. For example, if the number of physical interfaces and physical subinterface on the target
threat defense is 100 less than that of ASA with FPS then you can create the additional physical or
physical subinterfaces on the target threat defense.

• Subinterfaces are not created by the Secure Firewall migration tool. Only interface mapping is
allowed between physical interfaces, port channel, or subinterfaces.

Before you begin

Make sure you have connected to the management center and chosen the destination as threat defense. For
more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page 31.
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This step is not applicable if you are migrating to a management center without a threat defense device.Note

Step 1 If you want to change an interface mapping, click the drop-down list in the FTD Interface Name and choose the interface
that you want to map to that ASA with FPS interface.

You cannot change the mapping of the management interfaces. If a threat defense interface has already been assigned to
an ASA with FPS interface, you cannot choose that interface from the drop-down list. All assigned interfaces are greyed
out and unavailable.

You do not need to map subinterfaces. The Secure Firewall migration tool maps subinterfaces on the threat defense device
for all subinterfaces in the ASA with FPS configuration.

Step 2 When you have mapped each ASA with FPS interface to a threat defense interface, click Next.

What to do next

Map the ASA with FPS interfaces to the appropriate threat defense interface objects, security zones, and
interface groups. For more information, see Map ASA with FPS Interfaces to Security Zones and Interface
Groups.

Map ASA with FPS Interfaces to Security Zones and Interface Groups

If your ASA with FPS configuration does not include Access Lists and NAT rules or if you choose not to
migrate these policies, you can skip this step and proceed to Optimize, Review and Validate the Configuration,
on page 40.

Note

To ensure that the ASA with FPS configuration is migrated correctly, map the interfaces to the appropriate
threat defense interface objects, security zones. In an ASA with FPS configuration, access control policies
and NAT policies use interface names (nameif). In management center, those policies use interface objects.
In addition, management center policies group interface objects into the following:

• Security zones—An interface can belong to only one security zone.

• Interface groups—An interface can belong to multiple interface groups.

The Secure Firewall migration tool allows one-to-one mapping of interfaces with security zones and interface
groups; when a security zone or interface group is mapped to an interface, it is not available for mapping to
other interfaces although the management center allows it. For more information about security zones and
interface groups in management center, see Interface Objects: Interface Groups and Security Zones.

Step 1 On the Map Security Zones and Interface Groups screen, review the available interfaces, security zones, and interface
groups.

Step 2 To map interfaces to security zones and interface groups that exist in management center, or that is available in ASA
with FPS configuration files as Security Zone type objects and is available in the drop-down list, do the following:
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a) In the Security Zones column, choose the security zone for the interface.
b) In the Interface Groups column, choose the interface group for the interface.

Step 3 You can manually map or auto-create the security zones and interface groups.
Step 4 To map the security zones and interface groups manually, perform the following:

a) Click Add SZ & IG.
b) In the Add SZ & IG dialog box, click Add to add a new security zone or Interface Group.
c) Enter the security zone name in the Security Zone column. The maximum characters allowed is 48. Similarly, you

can add an Interface group.
d) Click Close.

For ASA with FPS Migration:

• Security Zone type ASA to Security Zone type Routed/Switched (threat defense supported) is supported for migration.

• Because, management center only accepts unique security zone names, new threat defense supported Security Zone
cannot have the same name as that of the source ASA with FPS zones.

• For all ASA type zones from the selected ASA with FPS that exists in source management center, a new threat
defense (Routed/Switched) zone is created in Secure Firewall migration tool under the Zone Mapping page. Unlike
in ASA to management center migration, in ASA with FPS scenarios, security zones are fetched from FPS policy
and are not created based on the threat defense Logical name (ASA nameif).

• The Interface Groups will be migrated using the threat defense logical name, and hence there will be no impact on
NAT.

The FPS Zones column, displays the security zones that is mapped to the ASA logical interface.

This column displays only the selected ASA with FPS device zones and list them against their respective
interfaces.

If one ASA with FPS zone is attached to more than one interface of the same ASA with FPS device, split
the zone into two threat defense supported zones.

Note

To map the security zones and interface groups through auto-creation, perform the following:

a) Click Auto-Create.
b) In the Auto-Create dialog box, check one or both of Interface Groups and Zone Mapping.
c) Click Auto-Create.

The Secure Firewall migration tool gives these security zones the same name as the ASA with FPS interface, such as
outside or inside, and displays an "(A)" after the name to indicate that it was created by the Secure Firewall migration
tool. The interface groups have an _ig suffix added, such as outside_ig or inside_ig. In addition, the security zones and
interface groups have the same mode as the ASA with FPS interface. For example, if the ASA with FPS logical interface
is in L3 mode, the security zone and interface group that is created for the interface is also in L3 mode.

Step 5 When you have mapped all interfaces to the appropriate security zones and interface groups, click Next.

Optimize, Review and Validate the Configuration

Step 1 (Optional) On the screen, click Optimize ACL to run the optimization code, and perform the following:
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a) To download the identified ACL optimization rules, click Download.
b) Select rules and choose Actions > Migrate as disabled or Do not migrate and apply one of the actions.
c) Click Save.

The migration operation changes from Do not migrate to disabled or vice-versa.

You can perform bulk selection of rules, using the following options

• Migrate—To migrate with default state.

• Do not Migrate—To ignore the migration of ACLs.

• Migrate as disabled—To migrate ACLs with State field set to Disable.

• Migrate as enabled—To migrate ACLs will with State field set to Enable.

Step 2 On the Optimize, Review and Validate Configuration screen, click Access Control Rules and do the following:
a) For each entry in the table, review the mappings and verify that they are correct.

A migrated Access Policy Rule uses the ACL name as prefix and appends the ACL rule number to it to make it
easier to map back to the ASA with FPS configuration file. For example, if an ASA with FPS ACL is named
"inside_access," then the first rule (or ACE) line in the ACL will be named as "inside_access_#1." If a rule must
be expanded because of TCP or UDP combinations, an extended service object, or some other reason, the Secure
Firewall migration tool adds a numbered suffix to the name. For example, if the allow rule is expanded into two
rules for migration, they are named "inside_access _#1-1" and " inside_access_#1-2".

For any rule that includes an unsupported object, the Secure Firewall migration tool appends an "_UNSUPPORTED"
suffix to the name.

b) If you do not want to migrate one or more access control list policies, check the box for the appropriate rows, choose
Actions > Do not migrate, and then click Save.

All rules that you choose not to migrate are grayed out in the table.

c) If you want to apply a management center file policy to one or more access control policies, check the box for the
appropriate rows, choose Actions > File Policy.

In the File Policy dialog, select the appropriate file policy and apply it to the selected access control policies and
click Save.

d) If you want to apply a management center IPS policy to one or more access control policies, check the box for the
appropriate rows, choose Actions > IPS Policy.

In the IPS Policy dialog, select the appropriate IPS policy and its corresponding variable set and apply it to the
selected access control policies and click Save.

e) If you want to change the logging options for an access control rule which has logging enabled, check the box for
the appropriate row and choose Actions > Log.

In the Log dialog, you can enable logging events either at the beginning or end of a connection or both. If you
enable logging, you must opt to send the connection events either to the Event Viewer or to the Syslog or both.
When you opt to send connection events to a syslog server, you can choose the syslog policies that are already
configured on the management center from the Syslog drop-down menu.

f) If you want to change the actions for the migrated access control rules in the Access Control table, check the box
for the appropriate row and choose Actions > Rule Action.

In the Rule Action dialog from the Actions drop-down, you can either choose ACP or Prefilter tabs:
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• ACP—Every access control rule has an action that determines how the system handles and logs matching
traffic. You can either perform an allow, trust, monitor, block, or block with reset action on an access control
rule.

• Prefilter—A rule's action determines how the system handles and logs matching traffic. You can either perform
a fastpath and block.

The IPS and file policies that are attached to an access control rule will be automatically removed for
all rule actions except the Allow option.

Tip

ACL Rule Category—The Secure Firewall migration tool preserves the Rule sections in the CSM managed ASA
configuration and migrates them as ACL categories on management center.

Policy capacity and limit warning—The Secure Firewall migration tool compares the total ACE count for the
migrated rules with the supported ACE limit on the target platform.

Based on the comparison result, the Secure Firewall migration tool displays a visible indicator and a warning
message if the total count of migrated ACE exceeds threshold or if it approaches the threshold of the supported
limit of target device.

You can optimize or decide not to migrate if the rules exceed the ACE Count column. You can also complete the
migration and use this information to optimize the rules after a push on the management center before deployment.

The Secure Firewall migration tool does not block any migration despite the warning.Note

You can now filter the ACE counts in the ascending, descending, equal, greater than, and lesser than filtering order
sequence.

To clear the existing filter criteria, and to load a new search, click Clear Filter.

The order that you sort the ACL based on ACE is for viewing only. The ACLs are pushed based on
the chronological order in which they occur.

Note

Step 3 Click the following tabs and review the configuration items:

• NAT Rules

• Objects (Access List Objects, Network Objects, Port Objects, VPN Objects, and Dynamic-Route Objects)

• Interfaces

• Routes

• Site-to-Site VPN Tunnels

• Remote Access VPN

Access List objects displays Standard and Extended ACL used in BGP, EIGRP, and RA VPN.

If you do not want to migrate one or more NAT rules or Route Interfaces, check the box for the appropriate rows,
choose Actions > Do not migrate, and then click Save.

All rules that you choose not to migrate are grayed out in the table.

Step 4 (Optional) While reviewing your configuration, you can rename one or more network, port, or VPN objects in the
Network Objects tab or the Port Objects tab, or the VPN Objects by choosing Actions > Rename.

Access Rules and NAT policies that reference the renamed objects are also updated with new object names.

Step 5 In the Dynamic-Route Objects section, all the supported objects that are migrated are displayed:
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• Policy-List

• Prefix-List

• Route-Map

• Community List

• AS-Path

• Access-List

Step 6 In the Routes section, the following routes are displayed:

• Static—Displays all IPv4 and IPv6 static routes.

• BGP—Displays all the BGP routes.

• EIGRP—Displays all the EIGRP routes.

For EIGRP, authentication keys are obtained if the more system:running configuration is uploaded and the keys
are unencrypted. If the key is encrypted in the source configuration, you can manually provide the key under the
interface section in EIGRP. You can select the authentication type (encrypted, unencrypted, auth, or none) and
provide the key accordingly.

• ECMP—Displays all the ECMP zones.

The only action which can be performed in this section is renaming the ECMP zones.Note

• PBR—Displays all the PBR routes.

Step 7 In the Remote Access VPN section, all objects corresponding to Remote Access VPN are migrated from ASA to
management center and are displayed:

• Anyconnect Files—AnyConnect packages, Hostscan Files (Dap.xml, Data.xml, Hostscan Package), External
Browser package, and AnyConnect profiles should be retrieved from the source ASA device and must be available
for migration.

As part of pre-migration activity, upload all AnyConnect packages to the management center. You can upload
AnyConnect profiles directly to the management center or from the Secure Firewall migration tool.

Select pre-existing Anyconnect, Hostscan, or External Browser Packages retrieved from the management center.
You must select atleast one AnyConnect package. You must select Hostscan, dap.xml, data.xml, or External
browser if available in the source configuration. AnyConnect profiles are optional.

Dap.xml must be the correct file retrieved from ASA. Validations are performed on dap.xml that are available in
the configuration file. You must upload and select all the required files for validation. Failure to update will be
marked as incomplete and the Secure Firewall migration tool does not proceed with validation.

• AAA—Authentication servers of Radius, LDAP, AD, LDAP, SAML, and Local Realm type are displayed. Update
the keys for all AAA servers. From Secure Firewall migration tool 3.0, the pre-shared keys are retrieved
automatically for a Live Connect ASA. You can also upload the source configuration with the hidden keys using
more system: running-config file. To retrieve the AAA authentication key in clear text format, follow the below
steps:

These steps should be performed outside the Secure Firewall migration tool.Note

a. Connect to the ASA through the SSH console.
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b. Enter the more system:running-config command.

c. Go to the aaa-server and local user section to find all the AAA config and the respective key values in clear
text format.

ciscoASA#more system:running-config

!

aaa-server Test-RADIUS (inside) host 2.2.2.2

key <key in clear text> <-----The radius key is now displayed in clear text format.

aaa-server Test-LDAP (inside) host 3.3.3.3

ldap-login-password <Password in clear text> <-----TheLDAP/AD/LDAPS password is now displayed

in clear text format.

username Test_User password <Password in clear text> <-----The Local user
password is shown in clear text.

If the password for the local user is encrypted, you can internally check for the password or
configure a new one on the Secure Firewall migration tool.

Note

• LDAPS requires domain on management center. You must update domain for encryption type LDAPS.

• Unique AD Primary Domain is required on management center for an AD server. If a unique domain is identified,
it will be displayed on the Secure Firewall migration tool. If conflict is found, you must enter a unique AD primary
domain to push the objects successfully.

For AAA server with encryption set to LDAPS, ASA supports IP and hostname or domain but the management
center supports only hostname or domain. If ASA config contains hostname or domain, it is retrieved and displayed.
If ASA config contains the IP address for LDAPS, enter a domain in theAAA section underRemote Access VPN.
You must enter the domain that can be resolved to the IP address of the AAA server.

For AAA server with type AD (server-type is Microsoft in ASA config), AD Primary Domain is a mandatory
field to be configured on a management center. This field is not configured separately on ASA and extracted from
the LDAP-base-dn config on ASA.

If the ldap-base-dn is: ou=Test-Ou,dc=gcevpn,dc=com

The AD Primary Domain is the field starting with dc, with dc=gcevpn, and dc=com that forms the primary
domain. The AD primary domain would be gcevpn.com.

LDAP-base-dn example file:

cn=asa,OU=ServiceAccounts,OU=abc,dc=abc,dc=com:

Here, dc=abc, and dc=com will be combined as abc.com to form the AD Primary Domain.

cn=admin, cn=users, dc=fwsecurity, dc=cisco, dc=com:

AD Primary Domain is fwsecurity.cisco.com.

AD Primary Domain is retrieved automatically and displayed on the Secure Firewall migration tool.

AD Primary Domain value needs to be unique for each Realm object. In case a conflict is detected
or if the Firewall Migration Tool is unable to find the value in the ASA config, you are requested to
enter an AD Primary Domain for the specific server. Enter the AD Primary Domain to validate the
configuration.

Note
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• Address Pool—All IPv4 and IPv6 pools are displayed here.

• Group-Policy—This section shows group policies with client profiles, management profiles, client modules, and
group policies without profiles. If the profile was added in the AnyConnect file section, it is displayed as pre-selected.
You can select or remove the user profile, management profile, and client module profile.

• Connection Profile—All connection profiles/tunnel groups are displayed here.

• Trustpoint—Trustpoint or PKI object migration from ASA to management center is part of the pre-migration
activity and is required for successful migration of RA VPN. Map the trustpoint for Global SSL, IKEv2, and
interface in the Remote Access Interface section to proceed with the next steps of migration. Global SSL and
IKEv2 Trustpoint are mandatory if the LDAPS protocol is enabled. If a SAML object exists, trustpoint for SAML
IDP and SP can be mapped in the SAML section. SP Certificate is optional. Trustpoint can also be overridden for
a specific tunnel-group. If the overriden SAML trustpoint configuration is available in source ASA, it can be
selected in Override SAML option.

For information on exporting PKI certificates from ASA, see Export PKI Certificate from ASA with FirePOWER
Services and Import into Management Center.

• Certificate Maps—Certificate maps are displayed here.

Step 8 (Optional) To download the details for each configuration item in the grid, click Download.
Step 9 After you have completed your review, click Validate.

During validation, the Secure Firewall migration tool connects to management center, reviews the existing objects, and
compares those objects to the list of objects to be migrated. If an object already exists in management center, the Secure
Firewall migration tool does the following:

• If the object has the same name and configuration, the Secure Firewall migration tool reuses the existing object
and does not create a new object in management center.

• If the object has the same name but a different configuration, the Secure Firewall migration tool reports an object
conflict.

You can view the validation progress in the console.

Step 10 When the validation is complete, if the Validation Status dialog box shows one or more object conflicts, do the
following:
a) Click Resolve Conflicts.

The Secure Firewall migration tool displays a warning icon on either or both of the Network Objects or Port
Objects tab, depending upon where the object conflicts were reported.

b) Click the tab and review the objects.
c) Check the entry for each object that has a conflict and choose Actions > Resolve Conflicts.
d) In the Resolve Conflicts window, complete the recommended action.

For example, you might be prompted to add a suffix to the object name to avoid a conflict with the existing
management center object. You can accept the default suffix or replace it with one of your own.

e) Click Resolve.
f) When you have resolved all object conflicts on a tab, click Save.
g) Click Validate to revalidate the configuration and confirm that you have resolved all object conflicts.
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Step 11 When the validation is complete and the Validation Status dialog box displays the message Successfully Validated,
continue with Push the Migrated Configuration to Management Center, on page 46.

Push the Migrated Configuration to Management Center
You cannot push the migrated ASAwith FPS configuration to management center if you have not successfully
validated the configuration and resolved all object conflicts.

This step in the migration process sends the migrated configuration to management center. It does not deploy
the configuration to the threat defense device. However, any existing configuration on the threat defense is
erased during this step.

Do not make any configuration changes or deploy to any device while the Secure Firewall migration tool is
sending the migrated configuration to management center.

Note

Step 1 In the Validation Status dialog box, review the validation summary.
Step 2 Click Push Configuration to send the migrated ASA with FPS configuration to management center.

The new optimization functionality in the Secure Firewall migration tool allows you to fetch the migration results quickly
using the Search filters.

The Secure Firewall migration tool also provides support to optimize CSV download and to apply the actions per page
view or on all rules.

The Secure Firewall migration tool displays a summary of the progress of the migration. You can view detailed, line-by-line
progress of which the components that are being pushed to management center in the console.

Step 3 After the migration is complete, click Download Report to download and save the post-migration report.

Copy of the Post-Migration Report is also saved in the Resources folder in the same location as the Secure Firewall
migration tool.

Step 4 If your migration failed, review the post-migration report, log file, and unparsed file carefully to understand what caused
the failure.

You can also contact the support team for troubleshooting.

Migration Failure Support

If the migration is unsuccessful, contact Support.

a. On the Complete Migration screen, click the Support button.

The Help support page appears.

b. Check the Support Bundle check box and then select the configuration files to download.

The Log and dB files are selected for download by default.Note

c. Click Download.

The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log files, DB,
and the Configuration files.
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d. Click Email us to email the failure details for the technical team.

You can also attach the downloaded support files to your email.

e. Click Visit TAC page to create a TAC case in the Cisco support page.

You can open a TAC case at any time during the migration from the support page.Note

Review the Post-Migration Report and Complete the Migration
The Post-migration report provides details on ACL count under various categories, ACL optimization, and
the overall view of optimization performed on the configuration file. For more information, see Optimize,
Review and Validate the Configuration, on page 40

Review and verify the objects:

• Category

• Total ACL rules (Source Configuration)

• Total ACL rules considered for Optimization. For example, Redundant, Shadow, and so on.

• ACL Count for optimization gives the total number of ACL rules counted before and after Optimization.

If you have missed to download the Post-Migration Reports during migration, use the following link to
download:

Post-Migration Report Download Endpoint—http://localhost:8888/api/downloads/post_migration_summary_
html_format

You can download the reports only when the Secure Firewall migration tool is running.Note

Step 1 Navigate to where you downloaded the Post-Migration Report.
Step 2 Open the post-migration report and carefully review its contents to understand how your ASA with FPS configuration

was migrated:

• Migration Summary—A summary of the configuration that was successfully migrated from ASA with FPS to
threat defense, including information about the interface, management center hostname and domain, target threat
defense device (if applicable), and the successfully migrated configuration elements.

• Selective Policy Migration—Details of the specific ASA with FPS feature selected for migration are available
within three categories - Device Configuration Features, Shared Configuration Features, and Optimization.

• ASA with FPS Interface to Threat Defense Interface Mapping—Details of the successfully migrated interfaces
and how youmapped the interfaces on the ASAwith FPS configuration to the interfaces on the threat defense device.
Confirm that these mappings match your expectations.

This section is not applicable for migrations without a destination threat defense device or if Interfaces
are not selected for migration.

Note
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• Source Interface Names to Threat Defense Security Zones and Interface Groups—Details of the successfully
migrated ASA with FPS logical interfaces and name and how you mapped them to security zones and interface
groups in threat defense. Confirm that these mappings match your expectations.

This section is not applicable if Access Control Lists and NAT are not selected for migration.Note

• Object Conflict Handling—Details of the ASA with FPS objects that were identified as having conflicts with
existing objects in management center. If the objects have the same name and configuration, the Secure Firewall
migration tool reused the management center object. If the objects have the same name but a different configuration,
you renamed those objects. Review these objects carefully and verify that the conflicts were appropriately resolved.

• Access Control Rules, NAT, and Routes You Chose Not to Migrate—Details of the rules that you choose not to
migrate with the Secure Firewall migration tool. Review these rules that were disabled by the Secure Firewall
migration tool and were not migrated. Review these lines and verify that all the rules you choose are listed in this
section. If desired, you can configure these rules manually.

• Partially Migrated Configuration—Details of the ASAwith FPS rules that were only partially migrated, including
rules with advanced options where the rule could be migrated without the advanced options. Review these lines,
verify whether the advanced options are supported in management center, and if so, configure these options manually.

• Unsupported Configuration—Details of ASA with FPS configuration elements that were not migrated because
the Secure Firewall migration tool does not support migration of those features. Review these lines, verify whether
each feature is supported in threat defense. If so, configure those features manually in management center.

• Expanded Access Control Policy Rules—Details of ASA with FPS access control policy rules that were expanded
from a single Point rule into multiple threat defense rules during migration.

• Actions Taken on Access Control Rules

• Access Rules You Chose Not to Migrate—Details of the ASA with FPS access control rules that you choose
not to migrate with the Secure Firewall migration tool. Review these lines and verify that all the rules you
choose are listed in this section. If desired, you can configure these rules manually.

• Access Rules with Rule Action Change—Details of all Access Control Policy Rules that had ‘Rule Action’
changed using the Secure Firewall migration tool. The Rule Action values are - Allow, Trust, Monitor, Block,
Block with reset. Review these lines and verify that all the rules you choose are listed in this section. If desired,
you can configure these rules manually.

• Access Control Rules that have IPS Policy and Variable Set Applied—Details of all ASA with FPS access
control policy rules that have IPS Policy applied. Review these rules carefully and determine whether the feature
is supported in threat defense.

• Access Control Rules that have File Policy Applied—Details of all ASA with FPS access control policy
rules that have File Policy applied. Review these rules carefully and determine whether the feature is supported
in threat defense.

• Access Control Rules that have Rule ‘Log’ Setting Change—Details of the ASA with FPS access control
rules that had ‘Log setting' changed using the Secure Firewall migration tool. The Log Setting values are -
False, Event Viewer, Syslog. Review these lines and verify that all the rules you choose are listed in this section.
If desired, you can configure these rules manually.

• Access Control Rules that have failed Zone-lookup—Details of the ASA with FPS access control rules that
fail the Route-lookup operation and that is populated in the Post-Migration Report. The Secure Firewall
migration tool performs the route-lookup operation based on the route (static and connected) information in
the source configuration to populate the destination security zones in the access rules.
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• Access Control Rules for Tunneled Protocols—Details of Tunnel rules that are migrated as a prefilter tunnel
rule during migration.

An unsupported rule that was not migrated causes issues with unwanted traffic getting through your firewall.
We recommend that you configure a rule in management center to ensure that this traffic is blocked by threat
defense.

Note

If it requires you to apply IPS or file policy to ACL in the Review and Validate page, you are highly
recommended to create a policy on the management center before migration. Use the same policy, as the
Secure Firewall migration tool fetches the policy from the connected management center. Creating a new
policy and assigning it to multiple policies may degrade the performance and may also result in a push failure.

Note

For more information about supported features in management center and threat defense, see Management Center
Configuration Guide, Version 6.2.3.

Step 3 Open the Pre-Migration Report and make a note of any ASA with FPS configuration items that you must migrate
manually on the threat defense device.

Step 4 In management center, do the following:
a) Review the migrated configuration for the threat defense device to confirm that all expected rules and other

configuration items, including the following, were migrated:

• Access control lists (ACL)

• Network Address Translation rules

• Port and network objects

• Routes

• Interfaces

• IP SLA objects

• Object Group Search

• Time-based objects

• VPN objects

• Site-to-Site VPN Tunnels

• Dynamic Route objects

b) Configure all partially supported, unsupported, ignored, and disabled configuration items and rules that were not
migrated.

For information on how to configure these items and rules, see the Management Center Configuration Guide. The
following are examples of configuration items that require manual configuration:

• Platform settings, including SSH and HTTPS access, as described in Platform Settings for Threat Defense

• Syslog settings, as described in Configure Syslog

• Dynamic routing, as described in Routing Overview for Threat Defense

• Service policies, as described in FlexConfig Policies

• VPN configuration, as described in Threat Defense VPN
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• Connection log settings, as described in Connection Logging

Step 5 After you have completed your review, deploy the migrated configuration from management center to the threat defense
device.

Verify that the data is reflected correctly in the Post-Migration Report for unsupported and partially supported rules.

The Secure Firewall migration tool assigns the policies to the threat defense device. Verify that the changes are reflected
in the running configuration. To help you to identify the policies that are migrated, the description of those policies
includes the hostname of the ASA with FPS configuration.

Uninstall the Secure Firewall Migration Tool
All components are stored in the same folder as the Secure Firewall migration tool.

Step 1 Navigate to the folder where you placed the Secure Firewall migration tool.
Step 2 If you want to save the logs, cut or copy and paste the log folder to a different location.
Step 3 If you want to save the pre-migration reports and the post-migration reports, cut or copy and paste the resources

folder to a different location.
Step 4 Delete the folder where you placed the Secure Firewall migration tool.

The log file is associated with the console window. If the console window for the Secure Firewall migration
tool is open, the log file and the folder cannot be deleted.

Tip

Sample Migration: ASA with FPS to Threat Defense 2100

Create a test plan that you can run on the target device after you complete the migration.

• Pre-Maintenance Window Tasks

• Maintenance Window Tasks

Note

Pre-Maintenance Window Tasks

Before you begin

Make sure you have installed and deployed a management center. For more information, see the appropriate
Management Center Hardware Installation Guide and the appropriate Management Center Getting Started
Guide.
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Step 1 Use the show running-config command for the ASA with FPS device or context that you are migrating and save a
copy of the ASA with FPS configuration. See View the Running Configuration.

Alternately, use Adaptive Security Device Manager (ASDM) for the ASA with FPS device or context that you want
to migrate and choose File > Show Running Configuration in New Window to obtain the configuration file.

For a multi context ASAwith FPS, you can use the show tech-support command to obtain the configuration
for all the contexts in a single file.

Note

Step 2 Review the ASA with FPS configuration file.
Step 3 Deploy the Firepower 2100 series device in your network, connect the interfaces and power on the appliance.

For more information, see Cisco Threat Defense for the 2100 Series Using Management Center Quick Start Guide.

Step 4 Register the Firepower 2100 series device to be managed by the management center.

For more information, see Add Devices to the Management Center.

Step 5 (Optional) If your source ASA with FPS configuration has port channels, create port channels (EtherChannels) on the
target Firepower 2100 series device.

For more information, see Configure EtherChannels and Redundant Interfaces.

Step 6 Download and run the most recent version of the Secure Firewall migration tool from https://software.cisco.com/
download/home/286306503/type.

For more information, see Download the Secure Firewall Migration Tool from Cisco.com, on page 23.

Step 7 When you launch the Secure Firewall migration tool, and specify destination parameters, make sure that you select the
Firepower 2100 series device that you registered to the management center.

For more information, see Specify Destination Parameters for the Secure Firewall Migration Tool, on page 31.

Step 8 Map the ASA with FPS interfaces with the threat defense interfaces.

The Secure Firewall migration tool allows you to map an ASAwith FPS interface type to the threat defense
interface type.

Note

For example, you can map a port channel in ASA with FPS to a physical interface in threat defense.

For more information, see Map ASA with FPS Configurations with Secure Firewall Device Manager Threat Defense
Interfaces.

Step 9 While mapping logical interfaces to security zones, click Auto-Create to allow the Secure Firewall migration tool to
create new security zones. To use existing security zones, manually map the ASA with FPS logical interfaces to the
security zones.

For more information, see Map ASA with FPS Interfaces to Security Zones and Interface Groups.

Step 10 Follow the instructions of this guide to sequentially review and validate the configuration to be migrated, and then push
the configuration to the management center.

Step 11 Review the Post Migration report, manually setup and deploy other configurations to the threat defense and complete
the migration.

For more information, see Review the Post-Migration Report and Complete the Migration, on page 47.
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Step 12 Test the Firepower 2100 series device using the test plan that you would have created while planning for migration.

Maintenance Window Tasks

Before you begin

Make sure you have completed all the tasks that must be performed before the maintenance window. See
Pre-Maintenance Window Tasks, on page 50.

Step 1 Connect to the ASA with FPS through the SSH console and switch to the interface configuration mode.
Step 2 Shutdown the ASA with FPS interfaces using the shutdown command.
Step 3 (Optional) Access the management center and configure dynamic routing for the Firepower 2100 series device.

For more information, see Dynamic Routing.

Step 4 Clear the Address Resolution Protocol (ARP) cache on the surrounding switching infrastructure.
Step 5 Perform basic ping tests from surrounding switching infrastructure to the Firepower 2100 series device interface IP

addresses, to make sure that they are accessible.
Step 6 Perform basic ping tests from devices which require layer 3 routing to Firepower 2100 series device interface IP addresses.
Step 7 If you are assigning a new IP address to the Firepower 2100 series device and not reusing the IP address assigned to the

ASA with FPS perform the following steps:

a. Update any static routes which refer to the IP address, so that they now point to the Firepower 2100 series device IP
address.

b. If you are using routing protocols, ensure that neighbors see the Firepower 2100 series device IP address as the next
hop for expected destinations.

Step 8 Run a comprehensive test plan and monitor logs within the managing management center for your Firepower 2100 device.
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C H A P T E R 3
Cisco Success Network-Telemetry Data

•

• Cisco Success Network - Telemetry Data, on page 53

Cisco Success Network - Telemetry Data
Cisco Success Network is an always-on usage information andmetrics collection feature in the Secure Firewall
migration tool, which collects and trasmits usage statistics through a secure cloud connection between the
migration tool and the Cisco cloud. These statistics help us provide additional support on unused features and
also improve our products. When you initiate a migration process in the Secure Firewall migration tool, the
corresponding telemetry data file is generated and stored in a fixed location.

When you push the migrated ASA with FPS configuration to management center, the push service reads the
telemetry data file from the location and deletes it after the data is successfully uploaded to the cloud.

Themigration tool provides two options to choose from, for streaming telemetry data—Limited andExtensive.

With Cisco Success Network set to Limited, the following telemetry data points are collected:

Table 2: Limited Telemetry

Example ValueDescriptionData Point

2023-04-25 10:39:19The time and date when the
telemetry data is collected

Time

ASAThe source device typeSource Type

ASA5585-SSP-10, 5969MBRAM,
CPU Xeon 5500 series 2000 MHz,
1 CPU (4 cores)

Model number of ASADevice Model Number

9.2 (1)Version of ASASource Version

6.5 or laterThe target version of management
center

Target Management Version

Management CenterThe type of target management
device, namely, management center

Target Management Type
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Example ValueDescriptionData Point

75The version of target deviceTarget Device Version

Cisco Secure Firewall Threat
Defense for VMware

The model of target deviceTarget Device Model

1.1.0.1912The version of the migration toolMigration Tool Version

SUCCESSThe status of the migration of ASA
configuration tomanagement center

Migration Status

The following tables provide information on the telemetry data points, their descriptions, and sample values,
when Cisco Success Network is set to Extensive:

Table 3: Extensive Telemetry

Example
Value

DescriptionData Point

Windows 7Operating system that runs the Secure Firewall migration tool. It could be
Windows7/Windows10 64-bit/macOS High Sierra

Operating
System

Mozilla/5.0Browser used to launch the Secure Firewall migration tool. It could be
Mozilla/5.0 or Chrome/68.0.3440.106 or Safari/537.36

Browser

Table 4: Source ASA with FPS Information

Example ValueDescriptionData Point

2023-04-25
10:39:19

The time and date when the telemetry data is
collected

Time

ASA with FPSThe source device typeSource Type

JAF1528ACADSerial number of ASASource Device Serial Number

ASA 5505-XModel number of ASASource Device Model Number

9.2(2)Version of ASA with FPSSource Device Version

504The total number of lines in the source
configuration

Source Config Counts

ROUTEDThe firewall mode configured on ASA - routed
or transparent

Firewall Mode

SINGLEThe context mode of ASA. This can be single
or multi-context.

Context Mode

ASA Config Statistics:

46The number of ACLs which are attached to
access group

ACL Counts
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Example ValueDescriptionData Point

46The total number of access rulesAccess Rules Counts

17The total number of NAT rulesNAT Rule Counts

34The number of network objects configured in
ASA

Network Object Counts

6The number of network object groups in ASANetwork Object Group Counts

85The number of port objectsPort Object Counts

37The number of port object groupsPort Object Group Counts

3The total number of unsupported access rulesUnsupported Access Rules Count

0The total number of unsupported NAT access
rules

Unsupported NAT Rule Count

7The number of FQDN -based access rulesFQDN Based Access Rule Counts

1The number of time range based access rulesTime range Based Access Rule
Counts

0The number of SGT-based access rulesSGT Based Access Rule Counts

Summary of Config lines that Tool is not able to parse

68The number of config lines that are unrecognized
by the parser

Unparsed Config Count

3The total number of unparsed access rulesTotal Unparsed Access Rule Counts

More ASA config details...

falseWhether RA VPN is configured on ASAIs RA VPN Configured

falseWhether Site-to-Site VPN is configured on ASAIs S2S VPN Configured

falseWhether BGP is configured on ASAIs BGP Configured

falseWhether EIGRP is configured on ASAIs EIGRP Configured

falseWhether OSPF is configured on ASAIs OSPF Configured

0The number of local users configuredLocal Users Counts

Table 5: Target Management Device (Management Center) Information

Example ValueDescriptionData Point

6.5 or laterThe target version of management centerTargetManagement Version

Management CenterThe type of target management device,
namely, management center

Target Management Type
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Example ValueDescriptionData Point

75The version of target deviceTarget Device Version

Cisco Secure Firewall Threat
Defense for VMware

The model of target deviceTarget Device Model

2.3.4The version of the migration too1Migration Tool Version

Table 6: Migration Summary

Example
Value

DescriptionData Point

Access Control Policy

Doesn't ExistThe name of access control policyName

10The total number of migrated FPS ACL rulesAccess Rule Counts ( FPS)

3The total number of partially migrated ACL rulesPartiallyMigratedACLRule Counts

0The number of expanded ACP rulesExpanded ACP Rule Counts

NAT Policy

Doesn't ExistThe name of NAT policyName

0The total number of migrated NAT rulesNAT Rule Counts

0The total number of partially migrated NAT rulesPartiallyMigrated NATRule Counts

More migration details...

0The number of updated interfacesInterface Counts

0The number of updated subinterfacesSub Interface Counts

0The number of static routesStatic Routes Counts

34The number of objects createdObjects Counts

6The number of object groups createdObject Group Counts

0The number of interface groups createdInterface Group Counts

3The number of security zones createdSecurity Zone Counts

21The number of objects reusedNetwork Object Reused Counts

1The number of objects that are renamedNetwork Object Rename Counts

0The number of port objects that are reusedPort Object Reused Counts

0The number of port objects that are renamedPort Object Rename Counts
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Example
Value

DescriptionData Point

44The number of pre-filter rules coming fromASAPrefilter rule counts

Table 7: Secure Firewall Migration Tool Performance Data

Example
Value

DescriptionData Point

14The time taken to parse ASA with FPS configuration lines (in minutes)Conversion Time

592The total time taken for end-to-end migration (in minutes)Migration Time

7The time taken to push the final configuration (in minutes)Config Push Time

SUCCESSThe status of themigration of ASAwith FPS configuration tomanagement
center

Migration Status

nullThe error message as displayed by the Secure Firewall migration toolError Message

nullThe description about the stage when the error has occurred and the
possible root cause

Error Description

Telemetry ASA with FPS Example File

The following is an example of a telemetry data file on the migration of ASA with FPS configuration to threat
defense:
"Verbatim_Comments": "Very good!",
"asa_config_stats": {
"Ipv6_access_rule_counts": 0,
"Ipv6_bgp_count": 0,
"Ipv6_nat_rule_count": 0,
"Ipv6_network_counts": 10,
"Ipv6_static_route_counts": 3,
"access_rules_counts": 39,
"acl_category_count": 0,
"acl_counts": 60,
"cert_based_auth": false,
"dm_inline_applied": 0,
"dm_inline_present": 0,
"dynamic_crypto_map": false,
"fqdn_based_access_rule_counts": 0,
"ikev1_count": 0,
"ikev2_count": 0,
"is_aaa_configured": false,
"is_anyconnect_configured": false,
"is_bgp_configured": false,
"is_eigrp_configured": false,
"is_ipv6_configured": true,
"is_multicast_configured": false,
"is_ospf_configured": false,
"is_pbr_configured": false,
"is_ra_vpn_configured": false,
"is_s2s_vpn_configured": false,
"is_snmp_configured": false,
"is_ssl_server_version_configured": false,
"is_webvpn_configured": false,
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"local_users_counts": 1,
"nat_rule_counts": 38,
"network_object_counts": 76,
"network_object_group_counts": 10,
"no_of_fqdn_based_objects": 6,
"ospfv3_count": 0,
"port_object_counts": 10,
"port_object_group_counts": 26,
"s2s_vpn_tunnel_counts": 0,
"s2s_vpn_vti": false,
"sgt_based_access_rules_count": 0,
"timerange_based_access_rule_counts": 0,
"total_unparsed_access_rule_counts": 3,
"tunneling_protocol_based_access_rule_counts": 0,
"unparsed_config_count": 115,
"unsupported_access_rules_count": 9,
"unsupported_nat_rule_count": 2,
"vpn_object_count": 0
},
"context_mode": "SINGLE",
"error_description": null,
"error_message": null,
"feedback_score": "5",
"firewall_mode": "ROUTED",
"log_info_acl_count": 0,
"migration_status": "SUCCESS",
"migration_summary": {
"access_control_policy": [
[{
"access_rule_counts": 16,
"apply_file_policy_rule_counts": 1,
"apply_ips_policy_rule_counts": 2,
"apply_log_rule_counts": 0,
"do_not_migrate_rule_counts": 0,
"enable_hit_count": false,
"expanded_acp_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_acl_rule_counts": 9,
"time_based_acl_count": 0,
"total_acl_element_counts": 98,
"update_rule_action_counts": 0
}]
],
"interface_counts": 0,
"interface_group_counts": 0,
"interface_group_manually_created_counts": 0,
"ip_sla_monitor_count": 0,
"nat_Policy": [
[{
"NAT_rule_counts": 0,
"do_not_migrate_rule_counts": 0,
"name": "Doesn't Exist",
"partially_migrated_nat_rule_counts": 1
}]
],
"network_object_rename_counts": 0,
"network_object_reused_counts": 83,
"object_group_counts": 10,
"objects_counts": 90,
"port_object_rename_counts": 0,
"port_object_reused_counts": 0,
"prefilter_control_policy": [
[{
"do_not_migrate_rule_counts": 0,
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"name": "Doesn't Exist",
"partially_migrated_acl_rule_counts": 0,
"prefilter_rule_counts": 44
}]
],
"security_zone_counts": 8,
"security_zone_manually_created_counts": 0,
"static_routes_counts": 0,
"sub_interface_counts": 0,
"time_out": false
},
"migration_tool_version": "2.4",
"mtu_info": {
"interface_name": null,
"mtu_value": null
},
"rule_change_acl_count": 0,
"selective_policy": {
"acl": false,
"acl_policy": false,
"application": false,
"csm": true,
"fps_acl": true,
"interface": false,
"interface_groups": true,
"migrate_tunneled_routes": false,
"nat": false,
"network_object": true,
"policy_assignment": true,
"policy_based_crypto_map": false,
"populate_sz": false,
"port_object": false,
"remote_deployment_enabled": false,
"route_based_vti": false,
"routes": false,
"s2s_vpn_flag": false,
"security_zones": true,
"unreferenced": false
},
"source_config_counts": 813,
"source_device_model_number": " ASAv, 8192 MB RAM, CPU Xeon E5 series 2600 MHz, 1 CPU (4
cores)",
"source_device_serial_number": "9A2EPUNLD80",
"source_device_version": "9.6(3)1",
"source_type": "ASAFPS",
"system_information": {
"browser": "Chrome/91.0.4472.124",
"operating_system": "Windows NT 10.0; Win64; x64"
},
"target_device_model": "Not Exists",
"target_device_version": "Not Exists",
"target_management_type": "6.6.1 (build 91)",
"target_management_version": "6.6.1 (build 91)",
"template_version": "1.1",
"time": "2021-07-14 19:10:59",
"tool_analytics_data": {
"objectsplit_100_count": 0
},
"tool_performance": {
"config_push_time": 6,
"conversion_time": 34,
"migration_time": 334
}
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C H A P T E R 4
Troubleshooting Migration Issues

• Troubleshooting for the Secure Firewall Migration Tool, on page 61
• Logs and Other Files Used for Troubleshooting, on page 62
• Troubleshooting ASA with FPS File Upload Failures, on page 62

Troubleshooting for the Secure Firewall Migration Tool
Amigration typically fails during the configuration file upload or during the push of the migrated configuration
to management center.

Secure Firewall Migration Tool Support Bundle

The Secure Firewall migration tool provides the option to download a support bundle to extract valuable
troubleshooting information like log files, DB, and configuration files. Perform the following:

1. On the Complete Migration screen, click the Support button.

The Help support page appears.

2. Check the Support Bundle check box and then select the configuration files to download.

The Log and dB files are selected for download by default.Note

3. Click Download.

The support bundle file is downloaded as a .zip to your local path. Extract the Zip folder to view the log
files, DB, and the Configuration files.

4. Click Email us to email the failure details for the technical team.

You can also attach the downloaded support files to your email.

5. Click Visit TAC page to create a TAC case in the Cisco support page.

You can open a TAC case at any time during the migration from the support page.Note
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Logs and Other Files Used for Troubleshooting
You can find information that is useful for identifying and troubleshooting issues in the following files.

LocationFile

<migration_tool_folder>\logsLog file

<migration_tool_folder>\resourcesPre-migration report

<migration_tool_folder>\resourcesPost-migration report

<migration_tool_folder>\resourcesunparsed file

Troubleshooting ASA with FPS File Upload Failures
ASA with FPS Configuration File Extraction Failure

The Secure Firewall migration tool does not support migration of ASDM-managed FPS rules into the Secure
Firewall migration tool. Therefore, you must be aware of the configuration information before you migrate
while selecting the source configuration (ASA or ASA with FPS). In such cases, you must use the source as
Cisco ASA at the beginning of the migration.
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C H A P T E R 5
Secure Firewall Migration Tool FAQs

• Secure Firewall Migration Tool Frequently Asked Questions, on page 63

Secure Firewall Migration Tool Frequently Asked Questions
Q. What are the new features supported on the Secure Firewall migration tool for Release 3.0.1?
A. The following features are supported with release 3.0.1:

• Migration of Enhanced Interior Gateway Routing Protocol (EIGRP) from ASA with FPS.

• Secure Firewall 3100 series is supported only as a destination device for migration.

Q. What are the new features supported on the Secure Firewall migration tool for Release 3.0?
A. The following features are supported with release 3.0:

• Remote Access VPN

• Site to Site VPN pre-shared key automation

Q. What are the new features supported on the Secure Firewall migration tool for Release 2.5.1?
A. The following features are supported with release 2.5.1:

• Dynamic Routes objects

• Border Gateway Protocol

Q. What are the new features supported on the Secure Firewall migration tool for Release 2.4?
A. The following features are supported with release 2.4:

• ASA with FPS migration to threat defense.
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• Migration of Certificate-based VPN into the management center.

Q. You have a Management Center with eight FPS security zones, FPS1 with five zones and FPS2 with
three zones. ACL policies attached to FPS1 uses a combination of both FPS1 and FPS2 zones in the
access rules. Will both FPS1 and FPS2 zones be migrated to threat defense?

A. The Secure Firewall migration tool will migrate FPS1 zones to threat defense zones. It will not migrate
FPS2 zones. However, the source ACLs using FPS2 will be migrated partially.

Q. How will the FPS User-based ACLs be migrated?
A. The Secure Firewall migration tool does not support migration of FPS User-based ACLs to the

management center. It removes the Users field and migrates the ACLs in disabled state. You must
manually add the Users field and enable the ACL as part of post-migration activity on the management
center.
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